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Part 1: Startup

The Startup part of this guide explains how to set up your 
notebook for the first time.

Part 2: Reference

The Reference part of this guide explains how to identify and use 
the hardware and software features on your notebook.
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Part-1
Startup

This Startup and Reference Guide provides information about 
setting up and using your notebook.

� To set up your notebook hardware and software for the first 
time, follow the procedures in “Part 1: Startup”.

� To learn more about using your notebook, refer to “Part 2: 
Reference.” To find information about a specific topic:

❏ Refer to the contents list on the first page of each chapter,

or

❏ Refer to the Index.
Startup and Reference Guide—Part 1 1–1
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Setting Up the Hardware
To set up the notebook for the first time, you need the notebook, 
the power cord 1, the AC adapter 2, and the battery pack 3.

Insert the battery pack into the notebook, so that the battery can 
begin to charge as soon as the notebook is connected to external 
power. (Refer to the next section for details.)

Open the notebook, connect it to external power, and press the 
power button to turn on the notebook.
 

Identifying the AC adapter, the power cord, and the battery pack 
(Power cords vary by region and country.)
1–2 Startup and Reference Guide—Part 1
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Inserting a Battery Pack
To insert the battery pack into the battery bay:

1. Turn the notebook upside down on a flat surface.

2. Insert the alignment tab on the battery pack into the 
alignment slot on the notebook.

3. Tilt the battery pack downward until it snaps into place.

Inserting a battery pack

Ä
CAUTION: To ensure that the correct drivers load and to prevent file 
corruption or damage to components, do not remove the battery pack 
until the notebook has been connected to external power.
Startup and Reference Guide—Part 1 1–3
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Opening the Notebook
To open the notebook:

1. Place the notebook display-side up on a flat surface near an 
electrical outlet.

2. Slide the display release latch 1, then lift the display 2.
 

Opening the notebook
1–4 Startup and Reference Guide—Part 1
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Connecting the Notebook to External Power
To connect the notebook to external power:

1. Plug the AC adapter cable into the power connector 1.

2. Plug the power cord into the AC adapter 2, then into an 
electrical outlet 3. 

As soon as the notebook is connected to external power, the 
battery light turns on, and the battery pack begins to charge.

Connecting the notebook to external power
Startup and Reference Guide—Part 1 1–5
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Charging a New Battery Pack
The battery pack begins to charge as soon as the notebook is 
connected to external power. Charge status is indicated by the 
battery charge light.

The battery charge light is on while the battery pack is charging. 

HP recommends that you leave the notebook connected to 
external power until the battery pack is fully charged and the 
battery charge light turns off.

A partially charged new battery pack can run the notebook, but 
battery charge displays will not be accurate until the new battery 
pack has been fully charged.

Identifying the battery light
1–6 Startup and Reference Guide—Part 1
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Turning On the Notebook
To turn on the notebook, press the power button. When the 
notebook turns on, the power/standby button lights up, the 
power/standby light turns on, and you are prompted to begin 
software setup.

Turning on the notebook

If the Notebook Does Not Turn On
� Make sure that the AC adapter is securely plugged into an 

electrical outlet.

� Make sure that the outlet is providing power. (To confirm that 
the outlet is providing power, plug another device into the 
outlet.)

� If you have installed a battery pack, make sure that the battery 
pack is firmly seated.

� Refer to the Worldwide Telephone Numbers booklet included 
with the notebook to contact an HP Customer Care Center.
Startup and Reference Guide—Part 1 1–7
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Setting Up the Software

Ä
CAUTION: To prevent file corruption and ensure that the correct drivers 
are installed, install software only when the notebook is connected to 
external power through the AC adapter. During the installation: 
� Do not unplug the notebook from external power.
� Do not shut down the notebook or initiate Standby or Hibernation.
� Do not insert, remove, connect, or disconnect any device, cable, 

or cord.

Installing Basic Software
When the notebook is connected to external power and turned on 
for the first time, a prompt to set up the operating system and 
other basic software is displayed on the screen. 

Before responding to the prompt and proceeding through the 
on-screen instructions, read the following carefully and follow 
the installation instructions in this chapter.

� After beginning the software setup, you must complete the 
entire process without interruption. Setup time varies.

� If you are prompted to select a language, choose carefully. On 
some models, the languages that you do not choose are 
deleted from the system and cannot be restored during the 
installation.

� Regional settings and most other preferences can be selected 
or changed later, after the operating system is installed.

� When you are prompted to accept the End User License 
Agreement, you must choose Accept to continue the 
software setup.

✎ During setup, it is normal for some notebook models to pause 
occasionally for up to 2 minutes and to restart several times. 
These pauses and restarts occur only during initial software setup. 
They will not occur during routine Windows startups.
1–8 Startup and Reference Guide—Part 1
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Installing Optional Software
Instructions for installing and using many of the applications and 
utilities included with the notebook are provided later in this 
guide. If you prefer to install optional software now, the following 
information may be helpful.

To install an application or a utility from a CD, refer to the 
instructions included with the CD. If printed instructions are not 
included in the CD package, they may be displayed on the screen 
when the CD is inserted.

To view or install preloaded utilities or applications, select Start > 
All Programs > Software Setup. Then:

� To display the descriptions and space requirements of a 
preloaded item without installing it, select the Next button, 
then select an item. After viewing the information, select the 
Cancel button.

� To install a preloaded item, select the check box for the item, 
select the Next button, then follow the instructions on the 
screen.
Startup and Reference Guide—Part 1 1–9
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Setting Regional and Display Preferences
Keyboard language and other regional preferences, such as time, 
date, and currency format, are set in the Regional Options 
window of the operating system. To access the Regional Options 
window, select Start > Control Panel > Date, Time, Language and 
Regional Options icon.

Screen appearance settings are accessed from the operating 
system Appearance and Themes window. To access the 
Appearance and Themes window, select Start > Control 
Panel > Appearance and Themes icon. To access the settings that 
control the size of the items displayed on the screen, select the 
Change Resolution task.

Turning Off the Notebook
Turn off the notebook by using the Windows shutdown 
procedure. Select Start > Turn Off Computer > Turn Off.

If the notebook does not respond, try the following emergency 
shutdown procedures in the order below:

� Press ctrl+alt+delete, click the Shut Down button, then select 
Shut Down from the drop down list.

� Press and hold down the power button for at least 4 seconds.

� Unplug the notebook from external power and remove the 
battery pack. For instructions refer to “Replacing a Battery 
Pack” in Chapter 4.
1–10 Startup and Reference Guide—Part 1
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Using the Notebook Safetly

Protecting the Notebook Against Computer 
Viruses

When you use the notebook for email, network, or Internet 
access, you expose the notebook to computer viruses. Computer 
viruses can disable the operating system, your applications, or 
your utilities or cause them to function abnormally.

Antivirus software can detect most viruses, destroy them, and 
in most cases repair damage they have caused. To provide 
protection against newly discovered viruses, antivirus software 
must be updated. 

For antivirus instructions and more information about virus 
updates, refer to the Help file within the application or select 
Start > Help and Support.
Startup and Reference Guide—Part 1 1–11
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Protecting the Notebook from Power Surges
To protect the notebook from the power surges that may be 
caused by an unreliable power supply or an electrical storm:

� Plug the notebook power cord into an optional, high-quality 
surge protector available from most computer or electronic 
retailers.

� Provide surge protection for the cable that connects the 
modem to the telephone jack.

� During an electrical storm, run the notebook on battery power 
or shut down the notebook and disconnect the power cord.

This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to part 15 of the FCC 
Rules. For more information, refer on the Documentation Library 
CD to the Regulatory and Safety Notices.

Å
WARNING: To reduce the risk of electric shock or damage to your 
equipment:
� Plug the power cord into an electrical outlet that is easily accessible 

at all times.
� Disconnect power from the product by unplugging the power cord 

from the electrical outlet.
� If provided with a three-pin attachment plug on your power cable, 

plug the cable into a grounded (earthed) three-pin outlet. Do not 
disable the power cord grounding pin. The grounding pin is an 
important safety feature.
1–12 Startup and Reference Guide—Part 1
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Å
WARNING: To reduce the risk of serious injury, read the Safety & 
Comfort Guide. It describes proper workstation setup, posture, and 
health and work habits for computer users, and provides important 
electrical and mechanical safety information. This guide is located on 
the Web at http://www.hp.com/ergo and on the hard drive or on the 
Documentation Library CD that is included with the product.

Å
WARNING: This notebook is designed to run demanding applications 
at full power. As a result of increased power consumption, it is normal 
for the notebook to feel warm or hot when used continuously. To avoid 
potential discomfort or burns, do not block the air vents or use the 
notebook on your lap for extended periods. The notebook complies with 
the user-accessible surface temperature limits defined by the 
International Standard for Safety of Information Technology Equipment 
(IEC 60950).

Getting Help
If you cannot solve a notebook problem by using this guide or the 
supplementary information, including the Troubleshooting guide, 
on the Documentation Library CD, you may need to contact HP.

Using the Help and Support Center
Installed on your notebook desktop is the Help and Support 
Center that provides a comprehensive online resource tool that 
can be used for the following:

� Troubleshooting assistance

� Downloading the latest driver updates and product 
information

� Learning more about using and maintaining your notebook
Startup and Reference Guide—Part 1 1–13

http://www.hp.com/ergo


Startup

Ryan Masterfile.book  Page 14  Monday, June 9, 2003  2:33 PM
With the Help and Support Center, you can get immediate 
assistance before contacting an HP support specialist. For 
example, in Help and Support, you can:

� Troubleshoot and fix common notebook problems.

� Learn how to use the software tools for working with your 
favorite music, video, games, and photos (select models).

� Get basic and detailed information about Windows XP for 
customizing your notebook.

� Set up your notebook for networking and for communicating 
on the Web.

� Use administration tools to manage areas such as passwords, 
file backups, system restore, and user accounts.

� Learn how to print, fax, run performance and maintenance 
tools, and install and configure new hardware.

� Protect your notebook files by using security and privacy 
features such as Norton AntiVirus software.

� Undo changes to your notebook with System Restore.

� Improve performance of your hard drive and battery pack.

� Download the latest drivers, utilities, software updates, and 
product documentation for your notebook.

� Use Tools to view notebook information and diagnose 
problems.

� Keep your notebook up-to-date using Windows Update.

� Find compatible hardware and software.

To access the online Help and Support Center:

1. Press the fn+f1 hotkey or select Start > Help and Support.

2. Follow the on-screen directions to select the online Help 
and Support Center feature that you need.
1–14 Startup and Reference Guide—Part 1
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Contacting Technical Support
If you cannot solve a problem using the Help and Support Center 
installed on your notebook or the documentation provided with 
your notebook, you can call technical support. 

To obtain a list of worldwide customer support telephone 
numbers, use either of the following methods:

� Select Start > Control Panel > Performance and Maintenance 
icon > System icon. Then, near the lower edge of the System 
Properties window, select the Support Information button.

� Refer to the Worldwide Telephone Numbers booklet included 
with the notebook to contact an HP Customer Care Center.

To provide the fastest possible resolution of your problem, have 
the notebook and the following information available when 
you call:

� Notebook serial number and model description, which are 
provided on labels affixed to the bottom of the notebook.

� Purchase date, as marked on your sales receipt/invoice.

� Conditions under which the problem occurred.

� Error messages that have displayed.

� Manufacturer and model of any optional printer connected.

� Operating system version number and registration number.

To view these numbers, select Start > Control Panel > 
System > General tab.

� Determine the version of the system ROM installed on the 
notebook.
Startup and Reference Guide—Part 1 1–15
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Display

Display

Display release latch Opens the notebook.
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Top

TouchPad

 

Top: TouchPad

1 TouchPad on/off button Enables/disables the TouchPad.

2 TouchPad light On: TouchPad is enabled.

3 TouchPad scroll zone* Scroll up or down.

4 Left and right TouchPad 
buttons*

Function like the left and right buttons 
on an external mouse.

5 TouchPad* Moves the pointer and selects or 
activates items on the screen.

*This table describes default settings. For information about changing the 
functions of TouchPad features, refer to “Setting TouchPad Preferences” in 
chapter 3.
Startup and Reference Guide—Part 2 2–3
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Keys

Top: Keys

1 Function keys Perform system and application tasks. 
When combined with the fn key, the 
function keys f1and f3 through f12 
perform additional tasks as hotkeys.
Refer to the “Hotkey Quick Reference” 
section in chapter 3 for details.

2 fn key Combines with other keys to perform 
system tasks. For example, pressing 
fn+f8 increases screen brightness.

3 Microsoft logo key Displays the Windows Start menu.

4 Applications key Displays a shortcut menu for items 
beneath the pointer.

5 Keypad keys (17) Standard numeric keypad.
2–4 Startup and Reference Guide—Part 2
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Power Controls

Top: Power Controls

Power button* When the notebook is:

� Off, press to turn on the notebook.

� On, briefly press to initiate Hibernation.

� In Standby, briefly press to resume from 
Standby.

� In Hibernation, briefly press to restore from 
Hibernation.

✎ If the system has stopped responding and 
Windows shutdown procedures cannot be 
used, press and hold for at least 
4 seconds to turn off the notebook.

*This table describes default settings. For information about changing 
the function of the power button or display switch, refer to “Managing 
Power Options” in chapter 4.
Startup and Reference Guide—Part 2 2–5
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Lights

Top: Lights

1 Wireless On/Off light On: An integrated wireless device has been 
enabled.

2 Caps lock light On: Caps lock is on.

3 Num lock light On: Num lock or the keypad is on.
2–6 Startup and Reference Guide—Part 2
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Audio Buttons

Top: Audio Buttons

1 Decrease volume button Pressing the left side, decreases 
system volume.

2 Mute button Mutes or restores volume.

3 Increase volume button Pressing the right side, increases 
system volume.
Startup and Reference Guide—Part 2 2–7
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Front Panel

 

Front Panel

1 Display release latch Opens the notebook.

2 Stereo speakers (2) Produce stereo sound.

3 Hard drive activity light On: The internal hard drive is being 
accessed.

4 AC power light On: The notebook is receiving AC power. 

5 Battery light On: The notebook is receiving battery 
power.
Flashing: A battery pack is 
malfunctioning and may need to be 
replaced.

6 Power/standby light On: Notebook is turned on.
Flashing: Notebook is in Standby.
2–8 Startup and Reference Guide—Part 2
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Rear Panel

Connectors and Jacks

 

Rear Panel: Connectors and Jacks

1 Security cable slot Attaches an optional security cable to 
the notebook.

2 RJ-11 telephone jack Connects a modem cable. (A modem 
cable is included with select models.)

3 RJ-45 network jack Connects an Ethernet network cable. 
(An Ethernet network cable is included 
with select models.)

4 USB connectors (3) Connect optional 1.1 or 2.0-compliant 
USB devices.

5 S-Video jack Connects an optional S-Video device, 
such as a television, VCR, camcorder, 
projector, or video capture card.

6 Parallel connector (available 
on select models)

Connects an optional parallel device 
such as a printer.

7 External monitor connector Connects an optional VGA external 
monitor or projector.
Startup and Reference Guide—Part 2 2–9
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Vents

 

Rear Panel: Vents

Exhaust vents Provides airflow to cool internal components.

Ä To prevent overheating, do not 
obstruct vents. Do not allow a hard 
surface, such as a printer, or a soft 
surface, such as a pillow, blanket, rug, 
or thick clothing, to block airflow.
2–10 Startup and Reference Guide—Part 2
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Left Side

Connectors and Jacks

Left Side: Connectors and Jacks

1 Power connector Connects an AC adapter cable.

2 Expansion port Connects to an optional HP Notebook 
Expansion Base.

3 USB connector Connects an optional 1.1 or 
2.0-compliant USB device.

4 1394 connector Connects an optional 1394 device, 
such as a camcorder.

5 Microphone jack Connects an optional monaural or 
stereo microphone.

6 Audio line-out jack Connects optional headphones or 
powered stereo speakers. Also 
connects the audio function of an 
audio/video device such as a television 
or VCR.
Startup and Reference Guide—Part 2 2–11
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Vents

 

Left Side: Vents

Exhaust vents Provide airflow to cool internal components.

Ä To prevent overheating, do not 
obstruct vents. Do not allow a hard 
surface, such as a printer, or a soft 
surface, such as a pillow, blanket, rug, 
or thick clothing, to block airflow.
2–12 Startup and Reference Guide—Part 2
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Right Side

 

Right Side

1 Infrared port Provides wireless communication 
between the notebook and an optional 
IrDA-compliant device.

2 Digital Media slot Supports SD, MMC, Memory Stick, 
and SmartMedia.

3 Optical drive release button Opens the optical drive.

4 Optical drive* Supports an optical disc.

5 PC Card eject button Ejects an optional PC Card from the 
PC Card slot.

6 PC Card slot Supports an optional Type I, Type II, or 
Type III 32-bit (CardBus) or 16-bit 
PC Card.

*The type of optical drive, such as a CD, DVD, or combination CD/DVD 
drive, varies by model.
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Bottom

Bays and Memory Compartment

Bottom: Bays and Memory Compartment

1 Battery pack release latch Releases a battery pack from the 
battery bay.

2 Memory compartment Contains 2 memory slots. Depending 
on the model, when the notebook is 
shipped either one or both memory 
slots may be filled with a replaceable 
memory module.

3 Hard drive bay Holds the internal hard drive.

4 Battery bay Holds a battery pack.
2–14 Startup and Reference Guide—Part 2
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Vents

 

Bottom: Vents

Intake vents Provide airflow to cool internal components.

Ä To prevent overheating, do not 
obstruct vents. Do not allow a hard 
surface, such as a printer, or a soft 
surface, such as a pillow, blanket, rug, 
or thick clothing, to block airflow.
Startup and Reference Guide—Part 2 2–15
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Labels
The labels affixed to the notebook and some notebook 
components provide information you may need when 
troubleshooting system problems or traveling internationally with 
the notebook.

� The Microsoft Certificate of Authenticity label contains the 
Product Key number. You may need this number to update or 
troubleshoot problems with the operating system.

� The system label provides regulatory information about the 
notebook.

� The product identification label contains the serial number of 
the notebook and a code describing the original configuration 
of the notebook. You will need the notebook serial number if 
you call customer support.

� The modem approvals label, which is affixed to an optional 
internal modem, provides regulatory information.

� Wireless certification labels, which are specific to various 
types of optional wireless devices provide regulatory 
information and lists the countries in which this optional 
wireless device has been approved for use.
2–16 Startup and Reference Guide—Part 2
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Additional Standard Components
The components included with the notebook vary by region, 
country, notebook model, and the optional hardware ordered. The 
following sections identify the standard external accessories and 
components included with most notebook models.

Cables and Cord

Additional Standard Components: Cables and Cord

1 Modem cable 
(included with select 
models)

Connects a modem to an RJ-11 telephone 
jack or to a country-specific modem adapter.

✎ A modem cable has a 6-pin, RJ-11 
telephone connector at each end.

2 Network cable 
(included with select 
models)

Connects the notebook to an Ethernet 
network jack.

✎ A network cable has an 8-pin, RJ-45 
network connector at each end.

3 Power cord* Connects an AC adapter to an AC electrical 
outlet.

*Power cords vary in appearance by region and country.
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Adapters and Battery Pack

Additional Standard Components: Adapters and 
Battery Pack

1 AC adapter Converts AC power to DC power.

2 Country-specific modem 
adapter (included by region 
as required)

Adapts the modem cable to a 
non-RJ-11 telephone jack.

3 Japan-specific outlet adapter 
(Japan only)

Connects the AC adapter to a 2-prong 
electrical outlet.

4 Battery pack Runs the notebook when the notebook 
is not connected to external power.
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Restoration and Documentation CDs
CDs for repairing or reinstalling software and for obtaining 
supplementary information about the notebook are included with 
the notebook. 

� For information about restoring, repairing, or reinstalling 
software, refer to “Software Updates, Restorations and 
Utilities.”

� For supplementary information about the notebook, refer to 
the Documentation Library CD. The Documentation Library 
CD provided with all models includes the following guides:

❏ Maintenance, Shipping and Travel Guide

❏ Troubleshooting Guide

❏ Modem and Networking Guide

❏ Regulatory and Safety Notices

❏ Safety & Comfort Guide
Startup and Reference Guide—Part 2 2–19



System Components

Ryan Masterfile.book  Page 20  Monday, June 9, 2003  2:33 PM
2–20 Startup and Reference Guide—Part 2



Ryan Masterfile.book  Page 1  Monday, June 9, 2003  2:33 PM
3
Keyboard
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TouchPad 

Identifying TouchPad Components
The TouchPad includes the following components:

Identifying TouchPad components

Button name Default assignment

1 TouchPad on/off button Enables/disables the TouchPad.

2 TouchPad light On: TouchPad is enabled.

3 TouchPad scroll zone Scroll up or down.

4 Left and right TouchPad 
buttons

Function like the left and right buttons 
on an external mouse.

5 TouchPad Moves the pointer and selects or 
activates items on the screen.
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Using the TouchPad
The TouchPad provides the navigation, selection, and scroll 
functions of an optional external mouse.

� To move the pointer, slide your finger across the TouchPad 
surface in the direction you want to move the pointer.

� If the pointer continues to move after you lift your finger 
from the TouchPad surface, wait a few seconds and the 
pointer will stop moving.

� To execute the click functions of the left or right button on 
an external mouse, press the left or right TouchPad button.

� To scroll up or down, slide your finger up or down in the 
scroll zone.

� To enable or disable the TouchPad, press the TouchPad 
button. When the TouchPad is enabled, the TouchPad light 
is on.

The notebook turns on with the TouchPad enabled. Users who 
work with keystrokes rather than mouse actions may prefer to 
disable the TouchPad to prevent accidental TouchPad activity.

Setting TouchPad Preferences
Pointer speed and shape, click speed, mouse trails, and other 
pointing device preferences are set in the operating system Mouse 
Properties window. To access Mouse Properties, select Start > 
Control Panel > Printers and Other Hardware > Mouse icon.
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Using Hotkey and Shortcut Keys
Hotkey and shortcut keys are preset combinations of the fn key 
with other keys on the keyboard.

� A hotkey is a combination of the fn key and one of the 
function keys. 

� A shortcut key is a combination of the fn key and a key other 
than a function key.

Identifying fn and Function Keys
The icons on the function keys f1, and f3 through f12 represent the 
hotkey functions available on the notebook.

Identifying hotkeys

Item Component

1 fn key

2 Function keys
3–4 Startup and Reference Guide—Part 2



Keyboard

Ryan Masterfile.book  Page 5  Monday, June 9, 2003  2:33 PM
Hotkey and Shortcut Key Quick Reference
The following table identifies the default hotkey and shortcut key 
functions.

✎ For information about changing the function of the fn+f5 hotkey, 
refer to the “Managing Power Options” section in chapter 4.

Default Function Key combination

Display System information. fn+esc

Open Help and Support window. fn+f1

Open Microsoft Internet Explorer. fn+f3

Switch display and image. fn+f4

Initiate Standby. fn+f5

Initiate QuickLock. fn+f6

Decrease display brightness. fn+f7

Increase display brightness. fn+f8

Play, pause, or resume an audio CD or DVD. fn+f9

Stop an audio CD or DVD. fn+f10

Play the previous track or chapter on an 
audio CD or DVD.

fn+f11

Play the next track on an audio CD or DVD. fn+f12
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Hotkey and Shortcut Key Procedures
To use a hotkey or shortcut key command on the notebook 
keyboard, use either of the following procedures:

� Briefly press the fn key, then briefly press the second key of 
the hotkeys command.

� Press and hold down the fn key, briefly press the second key 
of the hotkeys command, then release both keys at the 
same time.

Hotkey and Shortcut Key Commands

Display System Information (fn+esc)
Press fn+esc to display information about system hardware 
components and software version numbers. Press fn+esc a second 
time to remove the system information from the screen.

✎ When viewing system information, the system BIOS date is the 
version number of the system ROM. The BIOS date may display 
in a decimal format, such as 10/19/2002 F.07.

Open Help and Support Window (fn+f1)
The fn+f1 hotkey opens the Help and Support Center. From the 
Help and Support Center, you can access general information 
about your notebook, links to software updates and online 
technical support specialists, and other support features.

For more information about the Help and Support window, refer 
to the “Getting Help” section in “Startup.”

Open Internet Explorer (fn+f3)
The fn+f3 hotkey opens Internet Explorer. After you have set up 
your Internet or network services and your Internet Explorer 
home page, you can use the fn+f3 hotkey for quick access to 
your home page and the Internet.
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Switch Display (fn+f4)
The fn+f4 hotkey switches the image between display devices 
connected to the external monitor connector or the S-Video jack 
on the notebook. For example, if an external monitor is connected 
to the notebook, pressing the fn+f4 hotkey multiple times will 
toggle the image between the notebook display, the external 
monitor display, and a simultaneous display on both the notebook 
and the monitor.

Most external monitors receive video information from the 
notebook using the external VGA video standard. The fn+f4 
hotkey can also toggle images between other devices receiving 
video information from the notebook.

The following five video transmission types, with examples of 
devices that use them, are supported by the fn+f4 hotkey:

� LCD (notebook display)

� External VGA (most external monitors)

� S-Video (televisions, camcorders, VCRs, and video capture 
boards with S-Video-in jacks)

� Composite video (televisions, camcorders, VCRs, and video 
capture boards with composite-video-in jacks)

✎ Composite video devices can only be connected to the notebook 
when it is docked in an optional HP Notebook Expansion Base.
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Initiate Standby (fn+f5)
The fn+f5 hotkey is set by default to initiate Standby. Standby can 
be initiated only while the notebook is on. If the notebook is in 
Hibernation, you must restore from Hibernation before you can 
initiate Standby. 

To restore from Hibernation or resume from Standby, briefly 
press the power button. For more information about using 
Standby and Hibernation, refer to “Power.”

For information about changing the function of the fn+f5 hotkey, 
refer in chapter 4 to the “Managing Power Options” section.

Initiate QuickLock (fn+f6)
The fn+f6 hotkey initiates the operating system QuickLock 
security feature. The QuickLock feature disables the keyboard 
and displays the log on screen. QuickLock does not disable the 
TouchPad.

Before you can use the QuickLock feature, you must set a 
Windows system password. For instructions, refer to your 
operating system documentation. 

After you have set a Windows system password:

� To initiate QuickLock, press fn+f6.

� To exit QuickLock, enter your Windows system password.

Decrease Screen Brightness (fn+f7) 
The fn+f7 hotkey decreases notebook screen brightness. Hold 
down the hotkey to decrease the brightness level incrementally.

Increase Screen Brightness (fn+f8)
The fn+f8 hotkey increases notebook screen brightness. Hold 
down the hotkey to increase the brightness level incrementally.
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Play, Pause, or Resume an Audio CD or DVD (fn+f9)
The fn+f9 hotkey functions only when an audio CD or DVD is 
inserted. If the audio CD or DVD is:

� Not playing, press the fn+f9 hotkey to begin or resume 
the play.

� Playing, press the fn+f9 hotkey to pause the play.

Stop an Audio CD or DVD (fn+f10)
The fn+f10 hotkey stops the play of an audio CD or DVD that is 
playing. 

Play Previous Track of an Audio CD or DVD (fn+f11)
The fn+f11 hotkey plays the previously played track of an audio 
CD or DVD that is playing.

Play Next Track of an Audio CD or DVD (fn+f12)
The fn+f12 hotkey plays the next track of an audio CD or DVD 
that is playing.
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Keypad
The keypad consists of 17 keys that can be used like the keys on 
an external keypad.

Identifying the keypad keys
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Keyboard

Ryan Masterfile.book  Page 11  Monday, June 9, 2003  2:33 PM
Quick Launch Buttons
The three Quick Launch buttons enable you to use one keystroke 
to access a software application or to activate a wireless network 
device.

Identifying the Quick Launch buttons

✎ The settings for the Quick Launch buttons can be changed. Refer to the 
next section for information on reassigning these buttons to other 
applications.

Button name Default assignment

1 Media button Launches multimedia application.

2 Picture button Launches digital imaging application.

3 Wireless on/off butfton Turns the wireless network device on 
and off.
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Using Custom Assignments and Schemes
A Quick Launch button can be re-assigned to an Internet or 
network destination or to any software application or data file. 
For example, an Quick Launch button can be assigned to open 
your Internet browser to a favorite Web page or to open an 
application, such as Microsoft Word, or a document, such as an 
Excel worksheet, on a notebook or network drive.

Button assignments can be grouped into schemes. When you 
select a scheme, only the button assignments within that scheme 
are active. Button assignments and schemes are set up, changed, 
or deleted in the Quick Launch buttons window.

To program a Quick Launch button:

1. Select Start > All Programs > Utilities > Quick Launch.

2. On the Quick Launch tab, select the button you want to 
reprogram.

3. Type a label for the button, then select the application, 
document, folder, or Web site you want the button to open.

If you want a label to appear onscreen when you press a button, 
select that option on the Onscreen Display tab.
3–12 Startup and Reference Guide—Part 2



Ryan Masterfile.book  Page 1  Monday, June 9, 2003  2:33 PM
4
Power

Contents
Selecting a Power Source. . . . . . . . . . . . . . . . . . . . . . . . .  4–2
Understanding Standby, Hibernation and Shutdown. . . .  4–3

Standby  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–3
Hibernation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–4
Shutdown. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–5

Initiating Standby, Hibernation or Shutdown  . . . . . . . . .  4–6
When Leaving Your Work  . . . . . . . . . . . . . . . . . . . .  4–6
When External Power Supply is Uncertain . . . . . . . .  4–6
When Using Infrared or Drive Media . . . . . . . . . . . .  4–7

Using Default Power Settings  . . . . . . . . . . . . . . . . . . . . .  4–8
Identifying Power Controls and Indicators . . . . . . . .  4–8
Turning the Notebook or Display On or Off . . . . . . .  4–9
Using Emergency Shutdown Procedures  . . . . . . . .  4–10
Initiating or Resuming from Standby  . . . . . . . . . . .  4–11
Initiating or Resuming from Hibernation  . . . . . . . .  4–12

Managing Power Options. . . . . . . . . . . . . . . . . . . . . . . .  4–13
Using Battery Power  . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–16

Identifying the Power Lights . . . . . . . . . . . . . . . . . .  4–16
Switching Between Battery and External Power. . .  4–17
Charging a Battery Pack  . . . . . . . . . . . . . . . . . . . . .  4–17
Monitoring the Charge in a Battery Pack  . . . . . . . .  4–18
Managing Low-Battery Conditions . . . . . . . . . . . . .  4–19
Resolving Low-Battery Conditions . . . . . . . . . . . . .  4–20
Calibrating a Battery Pack. . . . . . . . . . . . . . . . . . . .  4–21
Storing a Battery Pack . . . . . . . . . . . . . . . . . . . . . . .  4–24
Battery Conservation Settings . . . . . . . . . . . . . . . . .  4–25

Replacing a Battery Pack . . . . . . . . . . . . . . . . . . . . . . . .  4–26
Disposing of a Used Battery Pack . . . . . . . . . . . . . . . . .  4–27
Startup and Reference Guide—Part 2 4–1



Power

Ryan Masterfile.book  Page 2  Monday, June 9, 2003  2:33 PM
Selecting a Power Source
The notebook can run on internal power from a battery pack or 
on external power from an AC adapter and other devices. The 
following table describes the best power source for general tasks.

Å
WARNING: This notebook is designed to run demanding applications 
at full power. As a result of increased power consumption, it is normal 
for the notebook to feel warm or hot when used continuously. To avoid 
potential discomfort or burns, do not block the air vents or use the 
notebook on your lap for extended periods. The notebook complies with 
the user-accessible surface temperature limits defined by the 
International Standard for Safety of Information Technology Equipment 
(IEC 60950).

Task Recommended Power Source

Work in most software 
applications.

� Charged battery pack in the 
notebook

� External power supplied through 
the following devices:

❐ AC adapter

❐ Optional HP Notebook 
Expansion Base

Charge or calibrate a battery 
pack in the notebook.

External power supplied through:

� AC adapter

� Optional HP Notebook 
Expansion Base

Install or modify system 
software or write to a CD.

External power supplied through:

� AC adapter

� Optional HP Notebook 
Expansion Base
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Understanding Standby, Hibernation 
and Shutdown

This section describes Standby, Hibernation, and shutdown and 
explains when to implement them. Standby and Hibernation are 
energy-saving features that can be initiated by you or by the 
system. 

Standby
Standby reduces power to system components that are not in use. 
When Standby is initiated, your work is saved in random access 
memory (RAM) and the screen is cleared.

� Saving your work before initiating Standby is not usually 
necessary, but is a recommended precaution.

� When the notebook is in Standby, the power/standby light 
flashes.

When you resume from Standby, your work returns to the screen 
where you left off.

Ä
CAUTION: To avoid a complete battery discharge, do not leave your 
notebook in Standby for extended periods. Connect to an external 
power source if your notebook will not be used for extended periods.

✎ The system will not initiate from Standby through touchpad 
movement.
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Hibernation
Hibernation takes a snapshot of the current system memory, saves 
it to the hard drive, then shuts down the notebook. When you 
resume from Hibernation, your work returns to the screen exactly 
as you left it. 

When possible, save your work before initiating Hibernation to 
prevent loss of data. Do not change the notebook configuration 
during Hibernation.

Ä
CAUTION: If the configuration of the notebook system is changed during 
Hibernation, it may not be possible to resume from Hibernation. When the 
notebook is in Hibernation:
� Do not add or remove memory modules.
� Do not insert or remove the hard drive.
� Do not connect or disconnect external devices.
� Do not insert or remove a CD or DVD.
� Do not insert a PC Card, SD Card, Memory Stick, Smart Media 

Card, or MMC.

If you cannot resume from Hibernation when power is restored to 
the system, you will be prompted to delete the restoration data 
and proceed with system boot. Unsaved data will be lost. If a 
power-on password has been set, the password must be entered to 
resume from Hibernation.

Hibernation is enabled by default, but can be disabled. To reduce 
the risk of power loss during a low battery condition, users should 
disable Hibernation only during a battery pack calibration.

Ä
CAUTION: If Hibernation is disabled, the system does not 
automatically save your system memory if the notebook reaches a 
critical low-battery condition.
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To verify that Hibernation is enabled, select Start > Control 
Panel > Performance and Maintenance > Power Options > 
Hibernate tab. Be sure that the Enable Hibernation check box is 
selected.

✎ Hibernation will not be displayed as a power option in the Power 
Options window if it has been disabled.

Shutdown
Shutdown procedures turn off the notebook. Whether to leave 
a battery pack in the notebook or in storage depends on how 
you work:

� Leaving the battery pack in the notebook enables the battery 
pack to charge whenever the notebook is connected to 
external power and also protects your work during a power 
outage.

� A battery pack in the notebook discharges more quickly, even 
when the notebook is turned off, than a battery pack that has 
been removed from the notebook and stored in a cool, dry 
location.
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Initiating Standby, Hibernation or 
Shutdown

The following sections describe when to initiate Standby or 
Hibernation and when to shut down your notebook.

When Leaving Your Work
Initiate Standby for shorter times and Hibernation for longer 
times or for more power conservation.

The amount of time a battery pack can support Standby or 
Hibernation or hold a charge varies by notebook configuration 
and the condition of the battery pack.

� Initiating Standby clears the screen, uses less power than 
leaving the notebook on, and your work returns quickly to the 
screen when you resume from Standby. A fully charged new 
battery pack can typically support Standby for up to 48 hours.

� Initiating Hibernation clears the screen and uses much less 
power than Standby. Returning to work saved in Hibernation 
takes longer than returning to work saved in Standby, but is 
faster than returning to your place manually after restarting 
the notebook. A fully charged new battery pack can typically 
support Hibernation for several weeks.

To extend the life of the battery pack when the notebook will be 
disconnected from external power for an extended period, shut 
down the notebook, remove the battery pack, and store it in a 
cool, dry location.

When External Power Supply is Uncertain
If an external power supply is uncertain, for example, because of 
an electrical storm, save your work, then initiate Hibernation or 
shut down the notebook.
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When Using Infrared or Drive Media
Standby and Hibernation interfere with the use of infrared 
communication and drive media.

� If the notebook is in Standby or Hibernation, you cannot 
initiate an infrared transmission.

� If Standby or Hibernation is accidentally initiated while drive 
media (such as a diskette, disk, CD, or DVD) is in use:

❏ Your playback may be interrupted.

❏ You may see a warning message: “Putting the computer 
into Hibernation or Standby may stop the playback. Do 
you want to continue?” Select No.

❏ Resume from Hibernation or Standby by briefly pressing 
the power button.

❏ Audio and video may resume, or you may need to restart 
the media.

Ä
CAUTION: Do not initiate Standby or Hibernation while using drive 
media. Doing so may result in video and audio degradation and loss of 
audio and video playback functionality.
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Using Default Power Settings
This section explains the default Standby, Hibernation, and 
shutdown procedures and includes information about turning the 
display on or off.

You can change many of these settings according to your 
preferences. If you want to change the default settings, refer to 
“Setting Power Options” later in this chapter.

Identifying Power Controls and Indicators
Standby, Hibernation, shutdown, and display procedures use the 
following controls and indicators:

1 Power button

2 Initiate Standby hotkey (fn+f5)

3 Power/standby light

Identifying Standby, Hibernation, shutdown, and display controls 
and indicators
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Turning the Notebook or Display On or Off
Task Procedure Results

Turn on the 
notebook.

Press the power button.

✎ Pressing the 
power button 
turns on the 
notebook from 
Standby, 
Hibernation, or 
shutdown.

� The power/standby light 
turns on.

� The operating system 
loads.

Shut down the 
notebook.*

Save your work and close 
all open applications. 
Then:

� Press the power button 
and follow the 
onscreen instructions 
(if displayed) for 
shutting down the 
notebook.

� Shutdown the 
notebook through the 
operating system. 
Select Start > Turn Off 
Computer > Turn Off.

� The power/standby light 
turns off.

� The operating system 
shuts down.

� The notebook turns off.

*If the system is unresponsive, and you are unable to shut down the notebook 
with this procedure, refer to the next section, “Using Emergency Shutdown 
Procedures.”
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Using Emergency Shutdown Procedures
If the notebook does not respond and you are unable to use 
normal Windows shutdown procedure, try the following 
emergency shutdown procedures in the sequence provided:

� Press ctrl+alt+delete. Select the Shut Down button, then select 
Shut down from the drop-down list.

� Press and hold down the power button for at least 4 seconds.

� Unplug the notebook from external power and remove the 
battery pack. For battery pack removal instructions, refer to 
the “Replacing a Battery Pack” section, later in this chapter.

Ä
CAUTION: Emergency shutdown procedures may result in the loss of 
unsaved data.
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Initiating or Resuming from Standby
Task Procedure Result

Initiate Standby With the notebook on, use 
either of the following 
procedures:

� Press the fn+f5 hotkey.

� Select Start > Turn off 
Computer > Stand by.

� The power/standby light 
flashes.

� The screen clears.

Allow the system 
to initiate 
standby

� If the notebook is running 
on battery power, the 
system initiates standby 
after 10 minutes of 
notebook inactivity (default 
setting).

� If the notebook is running 
on external power, the 
system does not initiate 
standby.

� Power settings and 
timeouts can be changed 
in the Power Options 
window.

� The power/standby light 
flashes.

� The screen clears.

Resume from 
user-initiated or 
system-initiated 
Standby.

� Press the power button. � The power/standby light 
turns on.

� Your work returns to the 
screen.
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Initiating or Resuming from Hibernation
Task Procedure Result

Initiate 
Hibernation

With the notebook on, use either 
of the following procedures:

� Briefly press the power 
button.

� Select Start > Shut Down > 
Hibernate. (If the Hibernate 
option is not displayed, press 
and hold shift.)

✎ If the notebook is in 
Standby, you must 
resume from Standby 
before you can initiate 
Hibernation.

� The power/standby 
light turns off.

� The screen clears.

Allow the system 
to initiate 
Hibernation (with 
Hibernation 
enabled)

� If the notebook is running on 
battery power, the system 
initiates Hibernation after 30 
minutes of notebook inactivity 
or when the battery pack 
reaches a critical low-battery 
condition.

� If the notebook is running on 
external power, the system 
will not initiate Hibernation.

� Power settings and timeouts 
can be changed in the Power 
Options window.

� The power/standby 
light turns off.

� The screen clears.

Resume from 
user-initiated or 
system-initiated 
Hibernation.

Press the power button.

✎ If the system initiated 
Hibernation because of 
a critical low-battery 
condition, connect 
external power or insert 
a charged battery pack 
before you press the 
power button.

� The power/standby 
light turns on.

� Your work returns to 
the screen.
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Managing Power Options
Many of the default power settings, such as timeouts and alarms, 
can be changed in Power Options. For example, you can set an 
audio alert to warn you when the battery reaches a low-power 
condition.

By default, when the notebook is on:

� Briefly pressing the power button initiates Hibernation.

� Pressing the fn+f5 hotkey, called the “sleep button” in the 
operating system, initiates Standby. 

� The display switch turns off the display. The display switch is 
activated by closing the display. 

Accessing the Power Options Window
To change the function of the power button, the fn+f5 hotkey, or 
the display switch:

1. Select Start > Control Panel > Performance and 
Maintenance icon > Power Options icon > Advanced tab.

❏ To change the power button function, select a function 
from the drop-down list for When I Press The Power 
Button On My Computer.

❏ To change the function of the fn+f5 hotkey, select a 
function from the drop-down list for When I Press The 
Sleep Button On My Computer.

❏ To change the display switch function, select a function 
from the drop-down list for When I Close The Lid Of My 
Portable Computer.

2. Select the OK button.

✎ The Hibernate function is available in the power button, sleep 
button, and display switch drop-down lists only if Hibernation is 
enabled.
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Displaying the Power Meter Icon
The Power Meter icon changes shape to indicate whether the 
notebook is running on a battery pack or external power. 
Double-click the icon to display the Power Options window.

To hide or show the Power Meter icon on the taskbar:

1. Access the Power Options window.

2. Select the Advanced tab.

3. Select or clear the Always show icon on the taskbar 
check box.

4. Select the OK button.

✎ If you cannot see an icon you have placed on the taskbar, the icon 
may be hidden. Select the arrow or vertical bar on the taskbar and 
expand it to view icons.

Setting or Changing a Power Scheme
The Power Schemes tab in the Power Options window assigns 
power levels to system components. You can assign different 
schemes depending on whether the notebook is running on a 
battery pack or external power.

You can also set a power scheme that initiates Standby or turns 
off the display or hard drive after a time interval that you specify.

To set a power scheme:

1. Access the Power Options window > Power Schemes tab.

2. Select the power scheme you wish to modify, and adjust 
options in the lists on the screen.

3. Select Apply.
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Using a Security Password
You can add a security feature that prompts you for a password 
when the notebook turns on or resumes from Standby or 
Hibernation.

To set a password prompt, access the Power Options window > 
Advanced tab. Select the check box for Prompt For Password 
When the Computer resumes from Standby, and select OK.
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Using Battery Power

Identifying the Power Lights
Battery pack procedures refer to the front panel lights:

Identifying the battery and power/standby lights

 

Top: TouchPad

1 Power/standby light On when the notebook has power.

2 Battery light � On in the absence of AC power, when 
the notebook is running on battery 
power.

� Flashing indicates that the battery pack 
is malfunctioning and may need to be 
replaced.

3 AC power light � On when notebook is connected to AC 
power.

� When AC power is available, the 
battery will charge.
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Switching Between Battery and External 
Power

The notebook switches between AC power and battery power 
according to the availability of an external AC power source, 
always preferring AC power. If the notebook contains a charged 
battery pack and is running on external AC power, the notebook 
will switch to battery power only if the AC adapter is 
disconnected from the notebook.

Keeping a battery pack in the notebook enables the battery pack 
to charge whenever the notebook is connected to external power 
and also protects your work in case of a power outage. On the 
other hand, a battery pack in the notebook slowly discharges even 
when the notebook is powered off. 

To prolong battery life, remove and store the battery pack if you 
will not be using the notebook for 2 weeks or more. Refer to 
“Storing a Battery Pack” later in this chapter for details.

Charging a Battery Pack
The battery pack charges whenever the notebook is connected to 
external power through an AC adapter.

The battery pack charges whether the notebook is turned off or 
turned on, but charges most quickly when the notebook is turned 
off. When the notebook is turned on, charging times are longer 
and vary with system activity.
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Monitoring the Charge in a Battery Pack

Obtaining Accurate Charge Information
To increase the accuracy of all battery charge displays:

� Allow the battery pack to fully discharge before charging it.

� Charge the battery pack fully. Even a new battery pack can 
display charge information inaccurately if it has not been 
fully charged.

� Fully charging and discharging the battery pack will reduce 
the need for battery calibration.

Displaying Charge Information
To display battery charge information on the screen, select Start > 
Control Panel > Performance and Maintenance icon > Power 
Options icon > Power Meter tab.

Power Meter displays battery status in both percent and time:

� The percent indicates the amount of charge remaining in the 
battery pack.

� The time indicates the approximate running time remaining 
on the battery pack if the battery pack continues to provide 
power at the current level. For example, the time remaining 
will decrease if you start playing a DVD and will increase if 
you stop playing a DVD.
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Managing Low-Battery Conditions
Some low-battery condition alerts and system responses can be 
changed in the Power Options window of the operating system. 
The information in this section describes the alerts and system 
responses set at the factory. Preferences set in the Power Options 
window do not affect lights.

Identifying Low-Battery Conditions
This section explains how to identify low and critical battery 
conditions.

Low-Battery Condition
When a battery pack that is the sole power source for the 
notebook reaches a low-battery condition (5 percent of a full 
charge), the battery light blinks.

Critical Low-Battery Condition
If a low-battery condition is not resolved, the notebook enters a 
critical low-battery condition (3 percent of a full charge).

In a critical low-battery condition:

� If Hibernation is enabled and the notebook is on or in 
Standby, the notebook initiates Hibernation.

� If Hibernation is disabled and the notebook is on or in 
Standby, the notebook remains briefly in Standby, then shuts 
down and loses your unsaved work.

To verify that Hibernation is enabled, be sure that the Enable 
Hibernate Support check box on the Hibernate tab is selected. To 
access the tab select Start > Control Panel > Performance and 
Maintenance > Power Options icon.
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Resolving Low-Battery Conditions

Ä
CAUTION: If the notebook has reached a critical low-battery condition 
and has begun to initiate Hibernation, do not restore power until the 
Power/Standby light turns off.

When External Power Is Available
To resolve a low-battery condition when external power is 
available, connect the AC adapter.

When a Charged Battery Pack Is Available
To resolve a low-battery condition when a charged battery pack is 
available, turn off the notebook or initiate Hibernation, insert a 
charged battery pack, then turn on the notebook.

When No Power Source Is Available
To resolve a low-battery condition when no power source is 
available, initiate Hibernation, or save your work and shut down 
the notebook.

When the Notebook Cannot Exit Hibernation
To resolve a low-battery condition when the notebook lacks the 
power to exit Hibernation:

1. Insert a charged battery pack or connect external power.

2. Exit Hibernation by briefly pressing the power button.
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Calibrating a Battery Pack

When to Calibrate
Even if a battery pack is heavily used, it should not be necessary 
to calibrate it more than once a month. It is not necessary to 
calibrate a new battery pack before first use. Calibrate the battery 
pack under the following conditions:

� When battery charge displays seem inaccurate.

� When you observe a significant change in battery run time.

� When the battery pack has not been used for one month 
or more.

How to Calibrate
To calibrate a battery pack, you must fully charge, fully 
discharge, then fully recharge the battery pack.

Charging the Battery Pack
Charge the battery pack while the notebook is in use. To charge 
the battery pack:

1. Insert the battery pack into the notebook. For instructions, 
refer to “Replacing a Battery Pack” later in this chapter.

2. Connect the notebook to external power. (The battery light is 
on as the battery pack charges.)

3. Leave the notebook connected to external power until the 
battery pack is fully charged. (The battery light turns off.)

Discharging the Battery Pack
Hibernation is enabled by default, but can be disabled. Before you 
begin the full discharge, disable Hibernation. To disable 
Hibernation, select Start > Control Panel > Performance and 
Maintenance > Power Options > Hibernate tab. Then clear the 
Enable Hibernation check box.
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ÄCAUTION: If you plan to leave the notebook unattended during 
discharge, save your work before starting the discharge 
procedure.

To fully discharge the battery pack:

1. Select the power icon on the taskbar or select Start > Control 
Panel > Performance and Maintenance icon > Power Options 
icon > Power Schemes tab.

2. Record all settings in the Plugged In column and all settings 
in the Running On Batteries column, so you can reset them 
after calibration.

3. Use the drop-down lists to set each item in both columns to 
Never.

4. Select the OK button.

5. Disconnect the notebook from the external power source, but 
do not turn off the notebook.

6. Run the notebook on battery power until the battery pack is 
fully discharged. When the battery pack is fully discharged, 
the battery light turns off and the notebook shuts down.

If you use the notebook occasionally during the discharge 
procedure and have set energy-saving timeouts, expect the 
following performance from your system during the discharge 
process:

� The monitor will not turn off automatically.

� Hard drive speed will not decrease automatically while the 
notebook is idle.

� System-initiated Standby will not occur.
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Recharging the Battery Pack
1. Connect the notebook to external power and keep the 

notebook connected until the battery pack is fully recharged 
and the battery light turns off. 

You can use the notebook while the battery pack is 
recharging, but the battery pack will charge faster if the 
notebook is turned off.

2. Select the Power icon on the taskbar or select Start > Control 
Panel > Performance and Maintenance icon > Power Options 
icon > Power Schemes tab.

3. Reenter the settings you recorded for the items in the Plugged 
In column and the Running on Batteries column.

4. Select the OK button.

Ä
CAUTION: After calibrating the battery pack, reenable Hibernation: 
select Start > Control Panel > Performance and Maintenance > Power 
Options > Hibernate tab, then select the Enable Hibernation check box.
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Storing a Battery Pack
If the notebook will be unused and unplugged for more than 
2 weeks, remove and store the battery pack.

Ä
CAUTION: To prevent damage to a battery pack, do not expose it to 
high temperatures for extended periods of time.

High temperatures accelerate the self-discharge rate of a stored 
battery pack. To prolong the charge of a stored battery pack, keep 
it in a cool, dry place.

Use the following table to estimate how long you can safely store 
a battery pack. The storage times provided are based on a battery 
pack that contains 50 percent of a full charge. A fully charged 
battery pack can be safely stored longer.

Temperature 
Range °F

Temperature 
Range °C Safe Storage Time

115°–140° 46°–60° Less than 1 month

79°–113° 26°–45° No more than 3 months

32°–77° 0°–25° 1 year
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Battery Conservation Settings
Using the following battery conservation settings and procedures 
extends the run time of a battery pack.

� Turn off wireless and local area network (LAN) connections 
and exit modem applications when you are not using them.

� Disconnect from the notebook any external devices that use 
power from the notebook. Battery run time is not affected by 
external devices that are plugged into an external power 
source.

� Stop or remove a PC Card you are not using. For more 
information, refer to the “Using a PC Card” section in 
Chapter 8.

� Disable or remove a Digital Media card (SD, MMC, Memory 
Stick, or SmartMedia) you are not using.

� Lower screen brightness.

� Lower system volume.

� Turn off a device connected to the S-Video jack.

� If you leave your work, initiate Standby or Hibernation or 
shut down the notebook.

� Select a short wait time, 5 minutes or less, for the monitor 
timeout. To change monitor timeout settings, select Start > 
Control Panel > Performance and Maintenance icon > Power 
Options icon > Power Meter tab. Select a short wait time 
from the Turn Off Monitor drop-down list, then select OK.
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Replacing a Battery Pack

Ä
CAUTION: To prevent loss of work when removing a battery pack that 
is the only power source, initiate Hibernation or turn off the notebook 
before removing the battery pack.

To replace the battery pack:

1. Turn the notebook upside down.

❏ To remove a battery pack, slide the battery release 
latch 1. (The battery pack tilts upward.) Then pull the 
battery pack out of the battery bay 2.

Removing a battery pack
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❏ To insert a battery pack, insert the alignment tab on the 
battery pack into the alignment slot on the notebook, then 
tilt the battery pack downward until it snaps into place.

Inserting a battery pack

2. To restore from Hibernation or to turn on the notebook, press 
the power button.

Disposing of a Used Battery Pack
For information about recycling or disposing of 
a used battery pack, refer on the Documentation 
Library CD to the Regulatory and Safety Notices 
guide.
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Understanding Drives
The hard drive and optical (CD/DVD) drive are standard 
features of the notebook, but the optical drive features vary by 
model. Some notebooks include a diskette drive and/or a USB 
Digital drive.

Adding a Drive to the System
Drives enable you to store and access data. An optional external 
drive can be added to the system by connecting it to one of the 
USB (Universal Serial Bus) or 1394 connectors on the notebook.

Additional data storage can be added with Digital Media 
including Secure Digital Card, Multimedia Card, Smart Media, 
and Memory Stick.

Types of Drives
Hard drives are for the storage of data files and of software such 
as system files, applications, and drivers. A hard drive is 
sometimes called a hard disk drive.

Optical drives include CD and DVD drives. Optical drives 
support DVDs and/or CDs, often called discs, which are used to 
store or transport data and to play music and movies. DVDs have 
a higher capacity than CDs. The notebook can read or write to 
optical drives as described in the following table.

Diskette drives support diskettes, which are used to store or 
transport data. The notebook can read or write to any diskette. 
A diskette drive is sometimes called a floppy disk drive.

Optical Drive Read Write

DVD-ROM drive Yes No 

DVD/CD-RW drive Yes Yes

DVD+RW Yes Yes
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Caring for Drives
Drives are fragile notebook components that must be handled 
with care. The following cautions apply to all drives. Additional 
cautions are included with the procedures to which they apply.

Ä
CAUTION: To prevent loss or damage to the notebook or a drive:
� Handle a drive carefully. Do not drop it.
� When inserting a drive, use only enough pressure to seat the drive. 

Excessive force can damage drive connectors.
� Do not spray a drive with a cleaner or other liquid or expose it to 

temperature extremes.
� Do not remove the primary hard drive (the hard drive in the hard 

drive bay) except for repair or replacement.
� Electrostatic discharge can damage electronic components. To 

prevent electrostatic damage to the notebook or a drive:

❏ Discharge yourself from static electricity before handling a drive 
by touching a grounded metal object, and

❏ Avoid touching the connectors on a drive. For more information 
about preventing electrostatic damage, refer to the Regulatory 
and Safety Notices on the Documentation Library CD.

� Avoid exposing a hard drive or a diskette to devices with magnetic 
fields. Security devices with magnetic fields include airport 
walk-through devices and security wands. The airport security 
devices that check carry-on luggage, usually while it is placed on a 
conveyor belt, use x-rays instead of magnetism and will not 
damage a hard drive or a diskette.

� If you mail a drive, ship it in packaging that protects it from shock, 
vibration, temperature, and high humidity. Label the package 
“FRAGILE.”

Ä
CAUTION: To prevent damage to drive media:
� Do not open the metal shutter of a diskette or touch the disk within 

the diskette case.
� Do not expose a diskette to a strong magnetic field, such as the 

security field used by a walk-through security device or a handheld 
security wand.

� Clean a CD or DVD only with a disc cleaning kit, available from 
most electronics retailers.
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Hard Drive
This section discusses the primary hard drive of the notebook.

Identifying the Hard Drive Activity Light
The hard drive activity light turns on when the internal hard drive 
is being accessed.

Identifying the hard drive activity light
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Replacing the Internal Hard Drive
The hard drive in the hard drive bay is the internal hard drive. 
Remove the internal hard drive only for repair or replacement.

Ä
CAUTION: To prevent an unresponsive system and loss of work, do not 
begin this procedure until you have:
� Saved your work, closed all open applications, and shut down the 

notebook.
� Disconnected the notebook from external power and removed the 

battery pack. 

1. Save your work and close all open applications.

2. Shut down the notebook and close the display.

3. Disconnect the notebook from external power.

4. Remove the battery pack.

5. Turn the notebook upside down.

6. Remove the 4 hard drive retaining screws from the hard 
drive bay.

Removing the hard drive retaining screws
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7. Remove the hard drive cover 1.

8. Using the handle, unseat the hard drive by sliding the hard 
drive towards the edge of the notebook 2, then remove it 
from the hard drive bay 3.

Removing an internal hard drive
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9. To install a hard drive, lower the hard drive into the hard drive 
bay 1, then slide the hard drive away from the notebook edge 
until it is fully seated 2. Lower the hard drive cover onto the 
hard drive bay 3.

Installing an internal hard drive
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10. If you have installed a hard drive, reinsert the 4 hard drive 
retaining screws. (If you removed but did not replace a hard 
drive, put the retaining screws in a safe place.)

Replacing the hard drive retaining screws

Optical Drive

Ä
CAUTION: To avoid playback distortion or damage to optical media, 
stop the CD or DVD and exit media software before inserting or 
removing an optical drive.
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Inserting an Optical Disc
1. Turn on the notebook.

2. Press the release button 1 on the drive bezel to release the 
media tray, then pull the tray outward until it is fully 
extended 2.

3. Position a CD or one-sided DVD over the tray, label side up.

4. Gently press the center of the disc onto the tray spindle 3 
until the disc snaps into place. Handle the disc by the edges, 
not the flat surfaces. (If the media tray is not fully extended, 
tilt the disc to position it over the tray spindle, then press it 
down into position.)

5. Close the media tray 4.

Inserting an optical disc into the optical drive
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Removing an Optical Disc (With Power)
1. Turn on the notebook.

2. Press the release button 1 on the drive bezel to release the 
media tray, then pull the tray outward until it is fully 
extended 2.

3. Remove the disc from the tray by gently pushing down on the 
spindle while pulling up on the outer edges of the disc 3. 
Handle the disc by the edges, not the flat surfaces. If the 
media tray is not fully extended, tilt the disc as you remove it.

4. Close the media tray.

5. Place the disc in a protective case.

Removing an optical disc from the optical drive when power 
is available
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Removing an Optical Disc (Without Power)
If the notebook is turned off or if no power is available, the 
release button on the optical drive will not work. To remove a disc 
from an optical drive without using the release button:

1. Insert a small object like the end of a paper clip into the 
release access 1 in the front bezel of the drive.

2. Press gently on the paper clip until the media tray is released, 
then pull the tray out until it is fully extended 2.

3. Remove the disc from the tray by gently pushing down on the 
spindle while pulling up on the outer edges of the disc 3. 
Handle the disc by the edges, not the flat surfaces. If the 
media tray is not fully extended, tilt the disc as you remove it.

4. Place the disc in a protective case.
 

Removing an optical disc from the optical drive when power is not 
available
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Playing an Optical Disc
You can play a CD in a CD drive or a DVD drive. You can play a 
DVD only in a DVD drive.

The information in this section applies to most optical drives and 
most disc software. For information about specific disc software, 
including Windows Media Player, WinDVD, and Easy CD 
Creator, refer to “Using Multimedia Software” in chapter 6.

Displaying Optical Disc Contents
When you insert a CD or DVD into the system, the notebook can 
play the medium, display its contents, take no action, or display a 
response prompt on the screen. You can choose how the notebook 
responds to the insertion of a medium by using the operating 
system AutoPlay feature. 

When AutoPlay is enabled, in most cases your notebook responds 
to the following procedures as described:

� To prevent an audio CD from opening when AutoPlay is 
enabled on the drive containing it, press the shift key as you 
insert the CD.

� To display the contents of a drive medium when the contents 
are not displayed by AutoPlay:

1. Insert the medium into the drive.

2. Select Start > Run, then type:

x:

where x = the designation of the drive containing the disc.

3. Press enter.
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Protecting Playback

Ä
CAUTION: Inserting or removing any device while running any 
multimedia application may pause or stop the play.

Ä
CAUTION: Initiating Standby or Hibernation while playing a drive 
medium may stop the play or diminish the quality of the play.

If Standby or Hibernation is accidentally initiated during 
playback:

� If you see the warning message “Putting the computer into 
Hibernation or Standby may stop the playback. Do you want 
to continue?” select No. (Audio and video may resume or you 
may need to restart the drive medium.)

� If Standby or Hibernation initiates and no warning message is 
displayed, resume from Hibernation or Standby by briefly 
pressing the power button, then restart the medium.

Observing the Copyright Warning
It is a criminal offense, under applicable copyright laws, to make 
unauthorized copies of copyright-protected material, including 
computer programs, films, broadcasts, and sound recordings. 
This notebook should not be used for such purposes.
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Setting the Boot Order
By default, the notebook starts up from the internal hard drive. 
You can set the notebook to start up from any bootable CD or 
DVD in the optical drive. A bootable CD or DVD contains files 
needed by the notebook to start up and operate properly. On some 
models, you can also start up from a drive connected to the 
notebook by USB.

Startup preferences are set in the Setup utility. The Setup utility is 
not a Windows utility and does not support the TouchPad. For 
information about using the Setup utility, refer to the “Using the 
Setup Utility” section in Chapter 9.
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Adjusting Volume
Volume can be adjusted by using the audio buttons on the 
notebook or by using the volume control software. The mute 
button overrides all software volume settings.

Using the Volume Buttons
To adjust volume using the audio buttons:

� To increase volume, press the increase volume button 3.

� To mute or restore volume, press the mute button 2.

� To decrease volume, press the decrease volume button 1.

Identifying the audio buttons
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Using the Volume Control
To place the volume control icon on the taskbar:

Select Start > Control Panel > Sounds, Speech, and Audio 
Devices > Sounds and Audio Devices icon > Volume tab. 
Select the Place volume icon in the task bar check box.

To adjust volume, click the volume control icon. To increase or 
decrease volume, select the slide bar and drag it up or down. To 
mute or restore volume, select or clear the Mute check box.

✎ If you cannot see an icon you have placed on the taskbar, the 
icons may be hidden. Select the arrow or thick vertical bar on the 
taskbar and expand to view icons.
6–4 Startup and Reference Guide—Part 2



Multimedia

Ryan Masterfile.book  Page 5  Monday, June 9, 2003  2:33 PM
Using the Speakers
The internal speakers plays sound in stereo from applications, the 
operating system, games, drive media, the Internet, and other 
sources.

✎ If an external device, such as a headset, is connected to the 
audio-out jack, the internal speakers are disabled.

Identifying the internal speakers

Connecting an Audio Device

Å
WARNING: To reduce the risk of personal injury, adjust the volume 
before putting on headphones or a headset.

Ä
CAUTION: To prevent possible damage to an external device, do not 
plug a monaural (single sound channel) plug into the audio-out jack.
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Identifying the Audio Jacks
The notebook has 2 audio jacks:

� The microphone jack 1, sometimes called the line-in jack, 
connects an optional monaural or stereo microphone. 

� The audio line-out jack 2, sometimes called a line-out jack, 
connects headphones or external stereo speakers. 

Identifying the audio jacks
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Using the Microphone Jack
When connecting a microphone to the microphone jack, use a 
monaural microphone with a 3.5-mm plug. A monaural electret 
condenser microphone is recommended.

� If you connect a stereo microphone, left channel sound will 
record on both channels.

� If you connect a dynamic microphone, the recommended 
sensitivity may not be achieved.

Using the Audio Line-Out Jack
The audio-out jack is also used to connect the audio functions of 
an audio/video device such as a television or VCR.

When you connect a device to the audio-out jack:

❏ Use only a 3.5-mm plug.

❏ For best sound quality, use 24-ohm to 32-ohm 
headphones.

❏ The internal speakers are disabled.
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Connecting an S-Video Device

Connecting the Audio
The S-Video jack supports video signals only. 

If you are setting up a configuration that combines audio and 
video functions, such as playing a DVD movie on your notebook 
and displaying it on your television, you will need a standard 
3.5-mm audio cable available from most computer or electronics 
retailers.

Plug the stereo end of the audio cable into the notebook audio-out 
jack. Plug the other end of the cable into the audio input jack on 
the external device.

Connecting the Video
To transmit video signals through the S-Video jack, you will need 
a standard S-Video cable available from most computer or 
electronics retailers. 

Plug either end of the S-Video cable into the notebook S-Video 
jack. Plug the other end of the cable into the S-Video input jack 
on the external device.

Identifying the S-Video jack
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Turning a Video Device On and Off
When an S-Video device is turned on, an image is displayed. 
When the device is off, an image is not displayed.

To turn on a video device that is connected to the notebook:

� Start or restart the notebook.

� Repeatedly pressing the fn+f4 hotkey toggles the image 
between the notebook display, any connected external 
monitor, and simultaneous display of the notebook and 
connected monitor.

� Switching the image to a connected video device turns on the 
video device.

� Switching the image to the notebook display only turns off 
the video device.

The preceding methods for turning a video device on and off are 
interchangeable. If you turned off a connected device in 
Windows, for example, you can turn on the device by either 
restarting the notebook or pressing the fn+f4 hotkey.

✎ To conserve power, turn off the device before disconnecting the 
device from the system.

Changing the Color Television Format
Color television formats are modes by which television video 
signals are sent and received. To send signals between the 
notebook and a television, both the notebook and the television 
must be using the same color television format.

The NTSC format is common in the United States, Canada, 
Japan, and South Korea. The PAL format is common in Europe, 
China, Russia, and Africa, and the PAL-M format is common in 
Brazil. Other South American and Central American countries 
may use NTSC, PAL, or PAL-M.
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Region-specific formats are set at the factory for most notebooks, 
but the region setting can be changed on any notebook. Refer to 
“Changing DVD Region Settings” later in this chaper.

Color television format settings are changed in the Setup utility. 
The Setup utility is not a Windows utility and does not support 
the TouchPad. For information about using the Setup utility, refer 
to the “Using the Setup Utility” section in Chapter 9.

Using Multimedia Software
This section provides guidelines for playing CDs and DVDs 
using Windows Media Player and WinDVD. This software 
supports the integrated optical drive on your notebook.

Playing Audio and Video CDs with Windows 
Media Player

The Windows Media Player application is a program included 
with the operating system.

Use Windows Media Player primarily for playing audio CDs. 
Although video CDs can be played using Windows Media Player, 
InterVideo WinDVD provides higher quality playback.

To open Windows Media Player and play a CD:

1. Insert a CD into the optical drive, then close the tray. 

2. If you do not have Autorun enabled, select Start > All 
Programs > Windows Media Player.

3. Select the Play button to play the CD.To stop the CD, use the 
on-screen Play button or Stop button, or use the media 
hotkeys described in the “Using Hotkey and Shortcut Keys” 
section of Chapter 3.

✎ To access Windows Media Player Help, select Help on the 
Windows Media Player menu bar.
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Playing Video CDs and DVDs with 
InterVideo WinDVD

InterVideo WinDVD is an application that enables you to play 
DVD movies or video CDs. WinDVD is preinstalled on the 
notebook. Some DVDs contain third-party DVD player programs 
such as PCFriendly that may interfere with WinDVD.

Installing WinDVD
If WinDVD has been uninstalled and you insert a DVD that 
contains a non-HP player program, you are prompted to install 
that non-HP player program.

If you prefer to use WinDVD, decline the non-HP player 
installation, close the installation window, and re-install 
WinDVD.

To re-install WinDVD:

1. Select Start > All Programs > Software Setup. A setup wizard 
loads, and a list of applications is displayed.

2. Select WinDVD and follow the instructions on the screen.

For more information about WinDVD, select Help on the 
WinDVD menu bar.

Playing a Video CD or DVD
For best playback quality, save and close all files and software 
unrelated to playing the DVD or video CD.

If a DVD displays a Playback Of Content From This Region Is 
Not Permitted error message, stop the DVD, change the region 
setting, then restart the DVD. For information about changing the 
region setting, refer to “Changing DVD Region Settings” in this 
chapter.
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To play a DVD or video CD:

1. Insert the DVD or video CD into the optical drive.

2. Assign WinDVD to play the video:

❏ If the Microsoft Windows XP AppPicker window is 
displayed, select Play Video By Using WinDVD.

❏ If the Microsoft Windows XP AppPicker window is not 
displayed, select Start > All Programs > InterVideo 
WinDVD > InterVideo WinDVD.

3. Follow the instructions on the screen.

✎ After you insert a DVD, a short pause is normal before Autorun 
opens the DVD and WinDVD Player.

Changing DVD Region Settings
Most DVDs that contain copyrighted files also contain region 
codes. The region codes help protect copyrights internationally.

You can play a DVD containing a region code only if the region 
code on the DVD matches the region setting on your DVD drive.

If the region code on a DVD does not match the region setting 
on your drive, a Playback Of Content From This Region Is Not 
Permitted message is displayed when you insert the DVD. To 
play the DVD, you must change the region setting on your 
DVD drive.

Ä
CAUTION: The region setting on your DVD drive can be changed only 
5 times.
� The region setting you select the fifth time becomes the permanent 

region setting on the drive.
� The number of allowable region changes remaining on the drive is 

displayed in the Remaining Times Until Permanent field in the 
WinDVD window. The number in the field includes the fifth and 
permanent change.
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To change the region setting on drive media:

1. Open WinDVD by doing one of the following:

❏ Select the WinDVD icon on the taskbar.

❏ Select Start > All Programs > InterVideo WinDVD > 
InterVideo WinDVD.

2. Right-click on the WinDVD player window.

3. Select Setup.

4. Select the button for the region.

5. Select the OK button.

Creating CDs with Roxio Easy CD & 
DVD Creator

Roxio Easy CD & DVD Creator is a data transfer utility that 
enables you to create or copy optical drive media. Before you can 
create CDs, you must install this application using the installation 
CD provided with your notebook.

✎ If your optical drive has DVD+RW capability, DVDs can be used 
with Easy CD and DVD Creator to store large amounts of data on 
a disc. To build DVDs containing movies, refer to “Creating 
DVDs Using InterVideo WinDVD Creator,” later in this chapter.

When Easy CD & DVD Creator is installed on your notebook 
model, a Roxio Easy CD and DVD Creator icon is displayed in 
Start > All Programs > Roxio Easy CD and DVD Creator.
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Understanding Easy CD & DVD Creator Features
Easy CD & DVD Creator includes the following 4 applications:

✎ Additional applications that appear in the Roxio Easy CD & DVD 
Creator online User’s Guide are not available on this notebook 
model, as purchased.

These applications can be accessed through the start menu or 
through the Home window. To open the Home window select 
Start > All Programs > Roxio Easy CD and DVD Creator > 
Home.

For a more information concerning Easy CD & DVD Creator 
applications, features, or use, refer to the Roxio Easy CD & DVD 
Creator online Userfs Guide. To access the guide, select Start > 
All Programs > Roxio Easy CD and DVD Creator > User’s 
Guide.

Application Allows you to

Disc Copier create backup copies of personal discs.

Creator Classic create CDs backups or archives of files on
your hard drive.

Drag-To-Disc “drag and drop” files to a CD or DVD and 
automatically record data was you would 
with a floppy disk. Drag-to-Disc does not 
copy and burn audio files.

Roxio Label Creator create personalized labels for your discs.
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Preparing to Use Easy CD & DVD Creator

Ä
CAUTION: To prevent loss of work and damage to a CD or DVD:
� Before writing to a CD, connect the notebook to a reliable external 

power source. Do not write to a CD while the notebook is running 
on battery power.

� Before writing to a CD, close all open applications (including 
screen savers and antivirus software) except Easy CD and DVD 
Creator.

� Do not copy directly from a CD to another CD or from a network 
drive to a CD. Instead, copy from a CD or network drive to your 
hard drive, then copy from your hard drive to the CD.

� Do not type on the notebook keyboard or move the notebook while 
the notebook is writing to a CD. The write process is sensitive to 
vibration.

Choosing Recording Media
HP recommends using high-quality media that correspond to the 
maximum speed of the optical drive. The notebook can write or 
copy to CDs which provide one-time, non-erasable recording 
(CD-R) or to CDs which provide erasable recording (CD-RW).

✎ In order to write data to a CD, you must use a blank CD-R or disc 
or a CD-RW disc on which the format has not been finalized. For 
more information about choosing media for use with Easy CD 
and DVD Creator, refer to the Roxio Easy CD and DVD Creator 
online User’s Guide.
Startup and Reference Guide—Part 2 6–15



Multimedia

Ryan Masterfile.book  Page 16  Monday, June 9, 2003  2:33 PM
Responding to the UDF Prompt
The first time you insert a CD into an optical drive, you may be 
prompted to install Universal Disk Format (UDF) Reader.

The UDF Reader is preinstalled on select notebook models. If 
UDF Reader is installed on your notebook, a CD created with the 
Drag-to-Disc application can be used in a compatible optical 
drive on a computer without Drag-to-Disc, provided you select 
the Make this disc readable on any CD-ROM or DVD-ROM drive 
option during the eject process.

Formatting Recording Media
To record information to a disc using Drag-to-Disc, use a CD 
formatted for Drag-to-Disc. Drag-to-Disc will automatically 
format blank discs.

✎ Formatting a disc in Drag-to-Disc may take up to 45 minutes to 
complete.

To record information to a CD using Creator Classic or Disc 
Copier, do not use a CD formatted for Drag-to-Disc or erase the 
information from a rewriteable disc to use it again.

To manually format a disc so that it can be used in Creator Classic 
or Disc Copier:

1. Insert a disc into the optical drive.

2. Open Drag-to-Disc by selecting Start > All Programs > 
Roxio Easy CD and DVD Creator > Drag-to-Disc.

3. Open the Drag-to-Disc menu.

4. Select Manually Format Disc, and choose the format settings.

❏ To format a disc for use with only Drag-to-Disc, select 
Quick Format.

❏ To format a disc for use with another application, select 
Full Format.

5. Select OK.
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To record information to a CD using Creator Classic or Disc 
Copier, do not use a CD formatted for Drag-to-Disc or erase the 
information from a rewriteable disc to use it again.

Creating CDs
Refer to the Roxio Easy CD and DVD Creator online User’s 
Guide for details on burning CDs.

Erasing Recorded Media with Roxio Easy CD 
& DVD Creator

✎ You cannot erase data from a CD-R or DVD+R disc. Only 
CD-RW or DVD+RW discs can be used in the following process.

✎ Erasing recorded media in Drag-to-Disc or Creator Classic may 
take up to 45 minutes to complete.

Erasing Recorded Media with Drag-to-Disc
To erase recorded media created with Drag-to-Disc:

1. Insert the CD into the optical drive.

2. Open the Drag-to-Disc window by selecting Start > All 
Programs > Roxio Easy CD Creator > Drag-to-Disc.

3. Open the Drag-to-Disc menu.

4. Select Erase Disc.

5. Select OK.
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Erasing Recorded Media with Creator Classic
To erase recorded media formatted with Creator Classic:

1. Insert the CD into the optical drive.

2. Open the Creator Classic window by selecting Start > All 
Programs > Roxio Easy CD and DVD Creator > Creator 
Classic.

3. In the Source window, select the optical drive containing the 
disc you wish to erase.

4. On the Creator Classic menu bar, select Disc > Erase Disc.

Selecting Easy CD & DVD Creator Settings
To use Drag-to-Disc, Creator Classic, or Disc Copier, the default 
settings shown in the following table must be selected. These 
settings are compatible; for example, the settings for 
Drag-to-Disc do not conflict with the settings for Disc Copier.

Application Required Settings

Drag-to-Disc Enable Auto Insert Notification*

Creator Classic Disable Disc-at-Once**
and
Enable Track-at-Once**

Disc Copier Disable Disc-at-Once

* Auto Insert Notification settings are selected through the operating 
system.
** Disk-at-Once and Track-at-Once are recording methods that appear 
in the Record Setup window after you begin burning a CD.
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The following table describes the Track-at-Once and 
Disc-at-Once recording methods.

For additional information about Track-at-Once or Disc-at-Once 
settings, refer to the Roxio Easy CD and DVD Creator online 
User’s Guide.

Creating DVDs Using InterVideo WinDVD 
Creator

InterVideo WinDVD Creator allows you to create, author, and 
edit movies and burn them to a DVD. Before you can create 
DVDs, you must install this application using the installation CD, 
included with select notebook. This application will not install 
successfully unless your notebook is equipped with an optical 
drive that has DVD+RW capability.

Option Description

Track-at-Once Writes data to the disc in multiple passes and 
allows you to copy one track or data file at a time to 
the disc. Additional options allow you to choose 
whether the session is finalized at the end of 
recording.

Disc-at-Once Writes all information to the disc at once and 
finalizes both the session and the disc at the end of 
recording.
Startup and Reference Guide—Part 2 6–19



Multimedia

Ryan Masterfile.book  Page 20  Monday, June 9, 2003  2:33 PM
Preparing to Use InterVideo WinDVD Creator

Ä
CAUTION: To prevent loss of work and damage to a DVD:
� Before writing to a DVD, connect the notebook to a reliable external 

power source. Do not write to a DVD while the notebook is running 
on battery power.

� Before writing to a DVD, close all open applications (including 
screen savers and antivirus software) except InterVideo WinDVD 
Creator.

� Do not copy directly from a DVD to another DVD or from a network 
drive to a DVD. Instead, copy from a DVD or network drive to your 
hard drive, then copy from your hard drive to the DVD.

� Do not type on the notebook keyboard or move the notebook while 
the notebook is writing to a DVD. The write process is sensitive to 
vibration.

Choosing Recording Media
HP recommends using high-quality media that correspond to the 
maximum speed of the optical drive. The notebook can write or 
copy to DVDs which provide one-time, non-erasable recording 
(DVD+R) or to DVDs which provide erasable recording 
(DVD+RW).

✎ In order to write data to a DVD, you must use a blank DVD+R 
disc or a DVD+RW disc on which the format has not been 
finalized. For more information about choosing media for use 
with WinDVD Creator, select Help on the WinDVD Creator 
menu bar.

Creating DVDs
To open InterVideo WinDVD Creator, select Start > All 
Programs > InterVideo WinDVD Creator> InterVideo WinDVD 
Creator.

For instructions on creating DVDs, select Help on the WinDVD 
Creator menu bar.
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Modem
All notebook models include an RJ-11 telephone jack, and a 
preinstalled V.92 modem. A modem cable with RJ-11 connectors 
at each end is also included with select models. 

If you purchased a notebook with an internal modem in a country 
where RJ-11 telephone jacks are not standard, a country-specific 
modem adapter is included with the notebook.

For best performance, you can connect to any Internet Service 
Provider (ISP) or modem network that has V.90 or V.92 
interoperable modems. Check with your ISP for a list of 
telephone numbers that support V.90 or V.92. (V.92 enables 
modem on-hold technology that allows an Internet session to be 
interrupted to answer a phone call, then resumes the Internet 
session after the call is complete.)

The maximum speed for faxing is 14.4 Kbps, even though the 
modem is capable of downloading at higher speeds.

Ä
CAUTION: Your built-in modem may not work with multiple phone 
lines or a private branch exchange (PBX), cannot be connected to a 
coin-operated telephone, and does not work with party lines. Some of 
these connections may result in excess electrical voltage and could 
cause a malfunction in the internal modem. Check your telephone line 
type prior to connecting your phone line.
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Connecting the Modem
A modem must be connected to an analog telephone line.

Å
WARNING: To reduce the risk of electric shock, fire, or damage to the 
equipment, do not plug a telephone cable into the RJ-45 network jack.

Å
WARNING: Connecting the notebook to a digital line can 
permanently damage the modem. Immediately disconnect your modem 
cable if accidentally connected to a digital line.

Ä
CAUTION: Jacks for digital PBX systems may resemble RJ-11 telephone 
jacks, but are not compatible with the modem.

For more information on connecting and configuring your 
modem, refer to the Modem and Networking Guide included on 
the Documentation Library CD.

Network
All notebook models ship with an RJ-45 network jack. A network 
cable with RJ-45 connectors at each end is included with select 
models. 

The notebook can be connected to a network whether or not the 
internal modem is connected to a telephone line.

If your notebook is connected to a network, you may want to 
confer with your network administrator before changing network 
settings.

The notebook supports network speeds up to 10 Mbps when 
connected to a 10BASE-T network and 100 Mbps when connected to 
a 100BASE-TX network.
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Connecting a Network Cable
For information on connecting a network cable, refer to the 
Modem and Networking Guide included on the Documentation 
Library CD.

Turning a Network Connection Off and On
To conserve power, turn off a network connection you are not 
using.

� To turn off a network connection, log off the network, then 
disconnect the network cable.

� To turn on a network connection, connect the network cable, 
then log on to the network.

Accessing the Network at Startup
To connect the notebook to a PXE (Preboot eXecution 
Environment) server during startup, you must enable the internal 
NIC for startup, then respond to the Network Service Boot 
prompt each time you want to connect to the server.

� To enable the NIC for startup and set the notebook to display 
the Network Service Boot prompt each time the notebook is 
started or restarted, set your preferences in the Setup utility. 
The Setup utility is not a Windows utility and does not 
support the TouchPad. For more information about using the 
Setup utility, refer to the “Using the Setup Utility” section in 
Chapter 9 of this guide.

� To respond to the Network Service Boot prompt, press f12 
while the prompt F12 = Boot from LAN appears very briefly in 
the lower left corner of the screen before Windows loads.
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Wireless (Select Models Only)
If your notebook is equipped with a wireless device, you can 
connect by radio to an 802.11b or 802.11g wireless local area 
network (WLAN) and access computers and other resources on 
the network.

A wireless network provides all the functions of a typical “wired” 
network, but also provides for “roaming.” Since your notebook 
connects to the network by radio rather than through cables, you 
can move from place to place within the network—from your 
office to a conference room, for example—and remain on the 
network the entire time.

Wireless antennae location

Å
WARNING: Exposure to Radio Frequency Radiation. The 
radiated output power of this device is below the FCC radio frequency 
exposure limits.  Nevertheless, the device should be used in such a 
manner that the potential for human contact during normal operation is 
minimized.  To avoid the possibility of exceeding the FCC radio 
frequency exposure limits, human proximity to the antenna should not 
be less than 20 cm (8 inches) during normal operation, including when 
the notebook display is closed.
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To Turn Wireless Communication On and Off
Wireless networks and cellular modems are examples of devices 
that use wireless communication. Such devices may be restricted 
in some situations or environments, such as when traveling in an 
airplane. If in doubt, be sure to ask for authorization before 
turning on your notebook wireless networking.

In Italy, Singapore, and possibly other countries, you may be 
required to purchase a license before using the wireless function.

Turning On Communication and Making a 
Connection

To turn on wireless communication and connect to a wireless 
network:

1. If the notebook is not on, turn it on.

2. Press the wireless on-off button (Quick Launch button) 
located above the number pad of the notebook to turn 
wireless 802.11b or 802.11g communication on and off

The wireless indicator light on the Wireless On/Off Quick 
Launch button turns on when 802.11b or 802.11g wireless 
communication is turned on.

To check the status of your wireless connection, open Network 
Connections in Control Panel, then select the connection.

Turning Off Communication and Ending a 
Connection

To end wireless communication and disconnect from a wireless 
notebook:

1. Close any files that reside on other network notebooks.

2. To turn off the wireless 802.11b or 802.11g communication 
without turning off the notebook, press the wireless on-off 
button.

Putting the notebook in Standby or shutting it down also turns off 
the wireless function.
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Connecting to a Wireless Network
You can connect to an access point that gives you access to a local 
area network, or you can connect directly to other computers in 
an “ad hoc” network.

Before you can connect your notebook to an existing 802.11b or 
802.11g wireless network, you have to configure the notebook.

For details on how to configure your notebook for wireless 
networking, open the Windows Help and Support Center and 
enter “wireless” as a search topic. This provides you with 
overviews, tutorials, articles, and step by step information on 
setting up your wireless device.
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Infrared
The notebook is IrDA-compliant and can communicate 
with another infrared-equipped device that is also 
IrDA-compliant. The IrDA connection speed standard is 
4 megabits per second (Mbps).

The infrared port supports low-speed connections up to 
115 kilobits per second (Kbps) as well as high-speed connections 
up to 4 Mbps.

Infrared signals are sent through an invisible beam of infrared 
light and must have an unobstructed line of sight. Infrared 
performance may vary with the performance of infrared 
peripherals, the distance and angle between infrared devices, and 
the applications being used.

Linking to an infrared device
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Setting Up an Infrared Transmission
For information about using infrared software and enabling or 
disabling infrared ports, refer to the operating system Help files 
and to the documentation included with the external infrared 
device.

To set up 2 infrared devices, such as the notebook and an optional 
printer, for optimal transmission:

� Position the devices so that their infrared ports face each 
other at a distance of no more than 3.3 feet (1 meter).

� Position the ports so that they face each other directly. The 
maximum capture angle is 30 degrees, so the ports must be 
aligned no more than 15 degrees off center.

� Shield the ports from direct sunlight, flashing incandescent 
light, and fluorescent light.

� Be sure that signals from a remote control or other wireless 
device (such as a cell phone, a headset, or an audio device) 
do not aim at either port.

� During the transmission, do not move either device and 
do not allow objects or movement to disrupt the beam.

Avoiding Standby While Using Infrared
Standby is not compatible with infrared transmission. If the 
notebook is in Standby, an infrared transmission cannot be 
initiated.

If Standby initiates during an infrared transmission, the 
transmission stops. To resume from Standby, briefly press 
the power button. The transmission resumes when the notebook 
resumes from Standby.
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External Devices
The jacks and connectors described in this guide support standard 
external devices.

� For information about which jack or connector to use, refer to 
the documentation included with the device.

� For information about installing or loading any software, 
such as drivers, required by the device, refer to the 
documentation included with the device.

To connect a standard external device to the notebook:

1. Turn off the notebook.

2. If you are connecting a powered device, turn off the device.

3. Connect the device to the connector on the notebook.

4. If you are connecting a powered device, plug the device 
power cord into a grounded electrical outlet.

5. Turn on the device.

6. Turn on the notebook.

To disconnect a standard external device from the notebook, turn 
off the device, then disconnect the device from the notebook.

Connecting a Monitor or Projector
To connect an external monitor or projector to the notebook, 
insert the monitor cable into the external monitor connector on 
the back of the notebook.

✎ If a properly connected external monitor or projector does not 
display an image, try pressing the fn+f4 hotkey to switch the image 
to the monitor.
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Connecting a USB Device
USB (universal serial bus) is a hardware interface that can be 
used to connect external devices such as a USB keyboard, mouse, 
drive, printer, scanner, or hub to the notebook or optional HP 
Notebook Expansion Base.

A hub is a connecting device that can be either powered or 
unpowered. USB hubs can be connected to a USB connector on 
the notebook or to other USB devices. Hubs can support several 
USB devices.

� Powered hubs must be connected to external power.

� Unpowered hubs must be connected either to a USB 
connector on the notebook or to a port on a powered hub.

The USB connectors on the notebook support USB 2.0 and 
earlier devices.

Some USB devices may require additional support software, 
which is usually included with the device. For more information 
and software installation instructions, refer to the documentation 
included with the device.
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Using a USB Device
To use a USB device, plug the device into one of the four USB 
connectors on your notebook.

Legacy USB 1.1 support is enabled by default. This supports a 
USB keyboard or hub connected to a USB connector on the 
notebook during startup (before Windows loads) or in a 
non-Windows application or utility.

Identifying the 3 USB connectors on the rear notebook and 1 USB 
connector on the left side

Using a PC Card
A PC Card is a credit card–sized accessory designed to conform 
to the standard specifications of the Personal Computer Memory 
Card International Association (PCMCIA). The notebook 
PC Card slot supports both 32-bit CardBus and 16-bit PC Cards.

PC Cards can be used to add modem, sound, storage, wireless 
communication, or digital camera functions to the notebook.
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Selecting a PC Card
A Type I, Type II, or Type III PC Card can be used. Zoomed 
video PC cards are not supported.

Configuring a PC Card

Ä
CAUTION: If you install all of the software or any of the enablers 
provided by a PC Card manufacturer, you may not be able to use other 
PC Cards. If you are instructed by the documentation included with 
your PC Card to install device drivers:
� Install only the device drivers for your operating system.
� Do not install other software, such as card services, socket services, 

or enablers, that may also be supplied by the PC Card 
manufacturer.
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Inserting a PC Card

Ä
CAUTION: To prevent damage to the PC Card connectors:
� Use minimal force when inserting a PC Card into a PC Card slot.
� Do not move or transport the notebook while a PC Card is inserted.

1. Hold the PC Card label-side up with the connectors facing 
the notebook.

2. Gently push the card into the slot until the card is seated.

Inserting a PC Card 
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Stopping and Removing a PC Card

Ä
CAUTION: To prevent loss of work or an unresponsive system, stop the 
PC Card before removing it.

✎ Stopping a PC Card, even if it is not in use, conserves power.

1. Close all applications and complete all activities that are 
supported by the PC Card.

2. To stop a PC Card, select the Safely Remove Hardware icon 
on the taskbar, then select the PC Card. (To display the Safely 
Remove Hardware icon on the taskbar, click the arrow icon 
for Show Hidden Icons.)

3. To release the PC Card, press the PC Card eject button 1. (If 
the PC Card button does not extend while a PC Card is in the 
PC Card slot, press the button once to extend the button, then 
press the button again to release the PC Card.)

4. Gently pull out the PC Card 2.

Removing a PC Card 
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Using Digital Media
The digital media slot supports the following digital media 
formats:

� Secure Digital (SD)

� Multimedia Card (MMC)

� Memory Stick (MS)

� SmartMedia (SM)

Ä
CAUTION: To prevent damage to the digital media card connectors:
� Use minimal force when inserting a SD, MMC, Memory Stick, or 

Smart Media into a Digital Media slot.
� Do not move or transport the notebook while Digital Media is 

inserted.

Digital media formats consist of flash memory cards that provide 
secure data storage and convenient data sharing. These cards are 
often used with digital media-equipped cameras and PDAs as 
well as other notebooks.
8–8 Startup and Reference Guide—Part 2



Hardware Options and Upgrades

Ryan Masterfile.book  Page 9  Monday, June 9, 2003  2:33 PM
Using the Digital Media Light
The digital media light turns on when an inserted Digital Media 
card is being accessed. The digital media light turns off when 
inserted digital media is inactive or when the digital media slot is 
empty.

Identifying the digital media light
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Inserting Digital Media
To insert a digital media card:

1. Hold the card label-side up with the connectors facing 
the notebook.

2. Gently push the card into the Digital Media slot until the card 
is seated. (The card will extend slightly beyond the edge of 
the notebook.)

Inserting a digital media card
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Removing Digital Media
To remove a Digital Media card:

1. Complete all activities that are supported by the card (such as 
a data transfer) and close all applications. 

2. Push the card in until it is released 1.

3. Pull the card out of the slot 2. 

Releasing and removing a digital media card

Disabling or Restarting Digital Media
An inserted Digital Media card uses power even when the card is 
not in use. Disabling the card conserves power.

To disable an inserted Digital Media card, double-click the My 
Computer icon on the Windows Desktop, right-click the drive 
assigned to the card, then select Eject. (The card is stopped but is 
not released from the Digital Media Card slot.)

To restart the card, remove, then reinsert, the card. For 
instructions, refer to “Inserting Digital Media” and “Removing 
Digital Media” in this chapter.
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Increasing Memory
You can increase the amount of RAM (random access memory) 
in the notebook with an optional HP-approved memory module.

The notebook memory slot supports one 128-MB, 256-MB, 
512-MB, or 1024-MB memory module.

Some notebook models ship with a vacant memory slot. On other 
models the memory slot contains a preinstalled memory module 
that can be replaced at any time.

Displaying Memory Information
When RAM is increased, the operating system increases the hard 
drive space reserved for the hibernation file.

If you experience problems with Hibernation after increasing 
RAM, verify that your hard drive has enough free space for the 
larger hibernation file.

� To display the amount of RAM in the system:

Select Start > Control Panel > Performance and 
Maintenance icon > System icon > General tab.

� To display the amount of free space on your hard drive, 
double-click My Computer and right-click the hard drive and 
select properties.

� To display the amount of space required by the 
hibernation file:

Select Start > Control Panel > Performance and 
Maintenance icon > Power Options icon > Hibernate tab.
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Removing or Inserting a Memory Module

Å
WARNING: To prevent exposure to electrical shock, access only the 
memory compartment during this procedure. The memory compartment 
and the battery and hard drive bays are the only user-accessible internal 
compartments on the notebook. All other areas that require a tool to 
access should be opened only by an HP authorized service provider.

Å
WARNING: To prevent exposure to electrical shock and damage to 
the notebook, shut down the notebook, unplug the power cord, and 
remove the battery pack before installing a memory module.

Ä
CAUTION: To prevent electrostatic discharge from damaging electronic 
components: before beginning this procedure, discharge yourself of 
static electricity by touching a grounded metal object. For more 
information about preventing electrostatic damage, refer on the 
Documentation Library CD to the Regulatory and Safety Notices guide, 
“Electrostatic Discharge” section.

1. Save your work and shut down the notebook. If you are not 
sure whether the notebook is off or in Hibernation, briefly 
press the power button. If your work returns to the screen, 
save your work, exit all applications, then shut down 
the notebook.

2. Disconnect all external devices connected to the notebook.

3. Disconnect the power cord.

4. Remove the battery pack.
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5. Turn the notebook upside down.

6. Remove the two memory compartment screws 1.

7. Slide the memory compartment cover towards the notebook 
display hinges and lift up to remove 2.

Opening the memory compartment 
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8. Remove or insert the memory module.

To remove a memory module:

a. Pull away the retention clips on each side of the 
module 1. (The module tilts upward.)

b. Grasp the edges of the module and gently pull the module 
out of the memory slot 2.

c. To protect a memory module after removal, place it in an 
electrostatic-safe container.

Removing a memory module
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To insert a memory module:

a. Align the keyed (notched) edge of the module with the 
keyed area in the memory slot 1.

b. With the module at a 45-degree angle from the surface 
of the memory compartment, press the module into the 
memory slot until it is seated 2.

c. Push the module down until the retention clips snap 
into place 3.

Inserting a memory module
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9. Align the tabs on the memory compartment cover with the 
cover slots on the notebook, then lower the cover and slide it 
towards the front of the notebook 1.

10. Reinsert and tighten the two memory compartment screws 2.

11. Replace the battery pack (if you removed a battery pack at the 
beginning of this procedure), reconnect external power, then 
restart the notebook.

Closing the memory compartment
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Connecting an Optional Cable Lock
The purpose of security solutions is to act a deterrent. The 
solutions do not prevent the product from being mishandled or 
stolen.

To install a security cable:

1. Loop the cable around a secured object.

2. Insert the cable lock key 1 into the cable lock.

3. Insert the cable lock 2 into the security cable slot 3.

4. Lock it with the cable lock key.

Connecting an optional cable lock
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Updating Software
For optimal notebook performance and to make sure your 
notebook remains compatible with changing technologies, install 
the latest versions of the software provided with your notebook as 
they become available.

To update notebook software:

Prepare for any update by identifying your notebook type, series 
or family, and model. Prepare for a ROM (read-only memory) 
update by identifying the ROM version currently installed on the 
notebook.

1. Access the updates at the HP Web site.

2. Download and install the updates.

✎ The notebook ROM stores the BIOS (basic input-output system). 
The BIOS determines how the notebook hardware interacts with 
the operating system and external devices and also supports such 
notebook services as time and date.

Preparing for a Software Update
If your notebook connects to a network, consult with your 
network administrator before installing any software updates, 
particularly a ROM update.

Accessing Notebook Product Information
To access the updates for your notebook, you will need the 
following information:

� The product category is Notebook.

� The product family name and series number are printed on 
the display bezel.

� More complete model information is provided on the serial 
number label on the bottom of the notebook.
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The product name, notebook model, and notebook serial number 
are also displayed in the same section of the Setup utility that 
displays ROM information, as described in the next section.

Accessing Notebook ROM Information
To determine whether an available ROM update is a later 
ROM version than the ROM version currently installed on the 
notebook, you need to know the version of the currently 
installed ROM.

ROM information is displayed in the Setup utility. The Setup 
utility is a non-Windows utility that does not support the 
TouchPad. For complete information about using the Setup 
utility, refer to the “Using the Setup Utility” section in Chapter 9.

1. To open the Setup utility, turn on or restart the notebook.

2. Before Windows opens and while the Press <F10> to enter setup 
prompt is displayed in the lower left section of the screen, 
press f10.

3. The ROM version and date are displayed in the System BIOS 
Version field.

4. To exit the Setup utility without changing any settings:

a. Press esc to close the window.

b. Use the arrow keys to select Ignore changes and exit, then 
press enter. 
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Downloading and Installing an Update
Most software at the HP Web site is packaged in a compressed 
file called a SoftPaq. Some ROM updates may be packaged in a 
compressed file called a RomPaq. Other ROM updates may be 
provided as a CPQFlash SoftPaq.

Most download packages contain a file named Readme.txt. 
Readme.txt contains detailed descriptive, installation, and 
troubleshooting information about the download. Readme.txt 
included with RomPaqs are English only. 

The following sections provide instructions for downloading and 
installing:

� A ROM update.

� A SoftPaq containing an update other than a ROM update.

Downloading and Installing a ROM Update

Ä
CAUTION: To prevent serious damage to the notebook or an unsuccessful 
installation, download and install a ROM update only while the notebook 
is connected to reliable external power. (Do not download or install a 
ROM update while the notebook is docked or running on battery power.) 
During the download and installation:
� Do not unplug the notebook from the electrical outlet.
� Do not shut down the notebook or initiate Standby or Hibernation.
� Do not insert, remove, connect, or disconnect any device, cable, 

or cord.

Downloading a ROM Update:
1. Access the page at the HP Web site that provides software for 

your notebook: Select Start > Help and Support, then select a 
software update link. Or, visit the HP Web site at:

http://www.hp.com/support

2. Follow the instructions on the screen to identify your 
notebook and access the ROM update you want to download.
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3. At the download area:

a. Record the date, name, or other identifier of any ROM 
update that is later than the ROM currently installed on 
your notebook. (You may need to identify the update 
later, after it has been downloaded to the hard drive.)

b. Record the path to the default or custom location on the 
hard drive to which the ROM package will download. 
(You may need to access the ROM package after it has 
been downloaded.)

c. Follow the online instructions to download your selection 
to the hard drive.

Installing a ROM Update
ROM installation procedures vary. Follow any instructions that 
are displayed on the screen after the download is complete. If no 
instructions are displayed:

1. Open Windows Explorer. To open Windows Explorer from 
the Start button, select Start > All Programs > Accessories > 
Windows Explorer.

2. In the left pane of the Windows Explorer window, select My 
Computer > your hard drive designation. (The hard drive 
designation is typically Local Disk C.) Then follow the path 
you recorded earlier to the folder on your hard drive 
containing the update.

3. To begin the installation, open the folder, then double-click 
the file with an .exe extension, for example, Filename.exe. 
(The ROM update installation begins.)

4. To complete the installation, follow the instructions on the 
screen.

✎ After a message on the screen reports a successful installation, 
you can delete the downloaded file from the destination folder.
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Downloading and Installing a Non-ROM SoftPaq
To update software other than a ROM update:

1. Access the page at the HP Web site that provides software for 
your notebook: Select Start > Help and Support, then select a 
software update link. Or, visit the HP Web site at:

http://www.hp.com/support

2. Follow the instructions on the screen to identify your 
notebook and access the SoftPaq you want to download.

3. At the download area:

a. Write down the date, name, or other identifier of the 
SoftPaq you plan to download. (You will need to 
identify the update later, after it has been downloaded to 
the hard drive.)

b. Follow the online instructions to download the SoftPaq to 
the hard drive.

4. When the download is complete, open Windows Explorer. To 
open Windows Explorer from the Start button, select Start > 
All Programs > Accessories > Windows Explorer. 

5. In the left pane of the Windows Explorer window, select My 
Computer > your hard drive designation, which is typically 
Local Disk C > HP.

6. In the HP folder, select the name or number of the software 
package you have downloaded.

7. Select the file that includes an .exe extension, for example, 
Filename.exe. (The installation begins.)

8. To complete the installation, follow the instructions on the 
screen.

✎ After a message on the screen reports a successful installation, 
you can delete the downloaded file from the HP folder.
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Backing Up and Restoring Data
The System Restore utility enables you to safeguard your system 
files and functional configurations by using System Restore 
points.

System Restore points are restorable “snapshots” or benchmarks 
of your system. The notebook may set System Restore points 
whenever you change personal settings or add software or 
hardware. Setting System Restore points manually provides 
additional protection for your system files and settings. HP 
recommends that you set System Restore points:

� Before you add or extensively modify software or hardware.

� Periodically, whenever the system is performing optimally.

Setting a System Restore Point
To set a System Restore point manually:

1. Select Start > Help & Support > Tools. (Notebook and 
diagnostic information is displayed.) 

2. Select System Restore, then follow the on-screen instructions 
for setting a Restore Point.

Restoring to a System Restore Point
To restore the notebook to a System Restore point:

1. Select Start > Help & Support > Tools. (Notebook and 
diagnostic information is displayed.) 

2. Select System Restore, then follow the on-screen instructions 
for restoring the notebook to a Restore Point.
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Repairing or Reinstalling the 
Operating System

The Operating System CD included with your notebook can be 
used to repair or reinstall the operating system. Either operations 
may take 1 to 2 hours to complete. 

� Repairing the operating system preserves your data and 
settings. 

� Reinstalling the operating system deletes all files on the 
notebook. After the operating system has been reinstalled, all 
device drivers must also be reinstalled.

HP recommends that you try to restore your system by using the 
System Restore utility before you consider repairing or 
reinstalling your operating system. For restoration instructions, 
refer to “Backing Up and Restoring Data” earlier in this chapter.

If a System Restore restoration fails to restore functionality, first 
try to repair the operating system. If the repair procedure does not 
restore functionality, you may need to reinstall the operating 
system.

Repairing the Operating System
To repair the operating system without deleting your 
personal data, use the Operating System CD that was shipped 
with the notebook:

1. Connect the notebook to external power and turn on the 
notebook.

2. Immediately insert the Operating System CD (included with 
the notebook) into the optical drive.

3. Press and hold the power button for 5 seconds to turn off the 
notebook.

4. Press the power button again to start the notebook.

5. When prompted, press any key to boot from CD. After a few 
minutes, the Welcome to Setup screen is displayed.
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6. Press enter to continue. A Licensing Agreement screen is 
displayed.

7. Press f8 to accept the agreement and continue. The Setup 
window is displayed.

8. Press R to repair the selected Windows installation. The repair 
process begins. The notebook restarts in Windows after the 
process is complete.

Reinstalling the Operating System
If the System Recovery and operating system repair procedures 
did not restore functionality to your notebook, it may be 
necessary to reinstall the operating system. 

Ä
CAUTION: Personal data and any software you have installed on the 
notebook will be lost during the operating system reinstall. To protect 
your data, back up your data before beginning the procedure. For back 
up information and instructions, select Start > Help and Support. Also 
refer to “Backing Up and Restoring Data” earlier in this section.

✎ During the reinstallation, you may be prompted for your product 
key. The product key is displayed on the Microsoft Certificate of 
Authenticity label on the bottom of the notebook.

To reinstall the operating system using the Operating System CD 
included with the notebook:

1. Connect the notebook to external power and turn on the 
notebook.

2. Immediately insert the Operating System CD into the 
optical drive.

3. Press and hold the power button for 5 seconds to turn off the 
notebook.

4. Press the power button again to start the notebook.

5. When prompted, press any key to boot from CD. After a few 
minutes, the Welcome to Setup screen is displayed.
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6. Press enter to continue. A Licensing Agreement screen is 
displayed.

7. Press f8 to accept the agreement and continue. The Setup 
window is displayed.

8. Press esc to continue installing a new copy of the operating 
system instead of repairing it.

9. Press enter to set up the operating system.

10. Press C to continue setup using this partition.

11. Select Format the partition using the NTFS file system 
(Quick), and press enter.

Ä Formatting a drive will delete all current files.

12. Press F to format the drive. The reinstallation process begins. 
This process may take up to 2 hours to complete. The 
notebook restarts in Windows after the process is complete.

Reinstalling Device Drivers and Other 
Software

After the installation process is complete, you must reinstall 
drivers and other software.

To reinstall drivers use the Driver Recovery CD included with the 
notebook:

1. While running Windows, insert the Driver Recovery CD into 
the optical drive.

If you do not have Autorun enabled, select Start > Run. Then 
type D:\SWSETUP\APPINSTL\SETUP.EXE (where D indicates the 
optical drive).

2. Follow the on-screen instructions for installing drivers.

After the drivers are reinstalled, you must reinstall any software 
you added to the notebook. Follow the installation instructions 
provided with the software.
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Installing a Retail Version of an 
Operating System

The Windows operating system provided on the notebook or 
on a restoration CD is enhanced by HP. The HP enhancements 
add power and security features and provide supplementary 
support for external devices such as drives and PC Cards.

Ä
CAUTION: Replacing an operating system enhanced by HP with a 
retail version of an operating system will result in the loss of all HP 
enhancements. In some cases, the loss of these enhancements may result 
in an unresponsive system or the loss of complete USB support.

Using the Setup Utility
The Setup utility is a preinstalled, ROM-based information and 
customization utility that can be used even when your operating 
system is not working or will not load. 

The utility reports information about the notebook and provides 
settings for startup, password, port, Setup utility appearance, and 
other preferences.

Opening the Setup Utility
To access most settings:

1. Start up or restart the notebook.

2. Before Windows opens and while the Press <F10> to enter setup 
prompt is displayed in the lower left corner of the screen, 
press f10.

On some models, you must start up (not restart) the notebook to 
access the settings for a hard drive password.
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Navigating and Selecting in the Setup Utility
Because the Setup utility is not Windows-based, it does not 
support the TouchPad. Navigation and selection are by keystroke.

� To navigate, use the up and down arrow keys or tab.

� To select an item, use the arrow keys to select the item, then 
press enter.

� To close a display but remain in the Setup utility, press esc.

An on-screen guide to navigation and selection is displayed at the 
lower edge of most Setup utility submenu screens. To minimize 
keystrokes by using the <Alt> Key Activates Accelerators 
feature:

1. Press and hold alt. (A letter or number in most on-screen items 
is highlighted.)

2. Press the keyboard key corresponding to the highlighted 
letter or number in the item you want to select.

For example, to select an on-screen OK button, press alt. 
When the “O” in OK is highlighted, press O. 

Restoring Setup Utility Default Settings
To return all Setup utility settings to default values, select File 
menu > Restore Defaults. (Identification information, including 
ROM version information, is retained.)

Exiting the Setup Utility
The Setup Utility exit options are on the File menu. When you 
select either option, Windows opens after the Setup utility closes.

� To close the utility and save your changes from the current 
session, select “Exit Saving Changes.”

� To close the utility without saving changes from the current 
session, select “Exit Discarding Changes.”
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A
Specifications

The information in this appendix may be helpful if you plan to 
use or transport the notebook internationally or in extreme 
environments.

Notebook Dimensions
Dimension Metric U.S.

Height (front) 4.25 cm 1.67 inches

Height (rear) 4.70 cm 1.85 inches

Width 39.80 cm 15.67 inches

Depth (with hinge) 28.8 cm 11.33 inches
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Operating Environment

Rated Input Power
The notebook operates on DC power, which can be supplied by 
an AC or a DC power source. Although the notebook can be 
powered from a stand-alone DC power source, HP strongly 
recommends that the notebook be powered only with an 
AC adapter supplied or approved by HP.

An AC adapter provided by HP for use with this notebook is 
capable of accepting AC power within the following 
specifications.

Factor Metric U.S.

Temperature

Operating 10° to 35° C 50° to 95° F

Nonoperating -20° to 60° C -4° to 140° F

Relative humidity (noncondensing)

Operating 10% to 90% 10% to 90%

Nonoperating 5% to 95% 5% to 95%

Maximum altitude (unpressurized)

Operating 3,048 m 10,000 ft

Nonoperating 9,144 m 30,000 ft

Input Power Rating

Operating voltage 100–240V AC @1.7A - 50–60Hz

Operating current 1.5A rms

Operating frequency range 50 to 60Hz
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The notebook is capable of accepting DC power within the 
following specifications.

This product is designed for IT power systems in Norway with 
phase-to-phase voltage not exceeding 240 Vrms.

Finding More Environmental 
Information

The specifications in this appendix contain information about 
exposing the notebook to environmental extremes.

� For similar information about storing battery packs, refer to 
the “Storing a Battery Pack” section in Chapter 4.

� For information about exposing the notebook to sunlight, 
ultraviolet light, x-rays, or magnetic fields, refer on the 
Documentation Library CD to the Maintenance, Shipping 
and Travel guide.

Input Power Rating

Operating voltage 18.5V DC @6.5A- 120W

Operating current 4.9A
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Index

1394 connector 2–11

A
AC adapter

connecting 1–5
identifying 2–18
power connector 2–11

AC power 1–12
adapter

AC 1–5, 2–18
country-specific modem 2–18
Japan-specific outlet 2–18

airport security devices 5–3
altitude specifications A–2
antivirus software 1–11
applications key 2–4
applications. See software; 

software updates
audio CD. See CD(s)
audio-out jack

connecting 6–6
identifying 2–11

AutoPlay 5–12

B
backup, system 9–7
battery bay

identifying 2–14
inserting battery pack 1–3
removing battery pack 4–26

battery light 2–8
battery pack

calibrating 4–21
charging 1–2, 1–6, 4–17, 4–21
discharging 4–21
inserting 1–3
monitoring charge 4–18
recharging 4–23
removing 4–26
storing 4–24
when to remove 4–5

battery power
conserving 4–25
when to use 4–6

BIOS (basic input output system) 
9–2

boot order 5–14
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button(s)
PC Card eject 2–13, 8–6
power 2–5
TouchPad 2–3, 3–3
volume 2–7, 6–3
See also key; latch; switch, 

display

C
cable

AC adapter 1–5
audio 6–8
modem 2–9, 2–17, 7–2
network 2–17
S-Video 6–8
See also power cord

cable lock, connecting 8–18
caps lock light 2–6
card and socket services, PC Card 

8–5
card. See memory, modules 

supported; PC Card; SD Card
CD drive. See drives
CD(s)

Driver Recovery 9–10
Operating System 9–9
playing, with Windows Media 

Player 6–10
playing, with WinDVD 6–11
starting from 5–14
See also drive media

Certificate of Authenticity label 
2–16, 9–9

compartment, memory 2–14, 8–12
connector(s)

1394 2–11
drive 5–3
external monitor 2–9
infrared port 2–13, 7–8
modem 2–9, 7–3
network 2–9, 7–3
parallel 2–9
power 2–11
USB 2–9, 2–11, 8–3

conservation, power 4–25
country-specific modem adapter

identifying 2–18
currency formats, setting 1–10
customer support 1–13, 2–19

D
date, setting the 1–10
device drivers, reinstalling 9–10
digital media

digital media light 8–9
disabling 8–11
inserting 8–10
inserting, removing 8–8
memory stick (MS) 8–7
multimedia card (MMC) 8–7
removing 8–11
secure digital (SD) 8–7
smartmedia (SM) 8–7
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display switch
function, changing 4–13
identifying 4–8

display, internal
brightness 3–8
opening 1–4
switching image 3–7

Documentation Library CD 2–19
drive media

affected by airport security 5–3
canceling AutoPlay on 5–12
caring for 5–3
displaying contents of 5–12
inserting, removing CD or 

DVD 5–9
types and terms 5–2

Driver Recovery CD 9–10
drivers, reinstalling 9–10
drives

affected by airport security 5–3
avoiding Standby and 

Hibernation while using 
optical 5–13

IDE drive light 5–4
inserting, removing media 5–8
shipping 5–3
starting from 5–14
types and terms 5–2
USB 8–3
See also hard drive, internal

DVD drive. See drives
DVD(s)

playing, with WinDVD 6–11
region settings 6–12
starting from 5–14
See also drive media

E
Easy CD and DVD Creator

creating CDs 6–13
erasing media 6–17
features 6–14
formatting media 6–16
preparing to use 6–15
settings 6–18
UDF prompt 6–16

eject button
optical drive 5–10
PC Card 8–6

electric shock warning 1–12
electrostatic discharge (ESD) 5–3, 

8–13
emergency shutdown procedures 

1–10, 4–10
enablers, PC Card 8–5
End User License Agreement 1–8
environmental specifications A–1
error message

Playback Of Content From This 
Region Not Permitted 6–11

ESD (electrostatic discharge) 5–3, 
8–13

exhaust vent 2–10, 2–12, 2–15
external monitor

connector 2–9
switching image 3–7

F
fan, vents 2–10, 2–12, 2–15
FCC notice 1–12
FDD (floppy disk drive) 5–2
flash memory card 8–8
flash RAM card 8–8
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fn key
changing Standby function 

4–13
identifying 2–4
Standby function 4–8

function keys 2–4

H
hard drive bay

identifying 2–14
replacing hard drive 5–5

hard drive, internal
defined 5–2
displaying amount of free space 

on 8–12
replacing 5–5
retaining screws 5–5, 5–8
space on, required for 

Hibernation file 8–12
See also drives

headphones 6–6
Help and Support window 3–6
Hibernation

avoiding when playing media 
5–13

changing configuration during 
4–4

controls and indicators 4–8
defined 4–4
identifying 5–5
initiating 2–5, 4–12
resuming from 4–12
setting preferences 4–13
when to use 4–4

hotkeys

changing function of fn+f5 
4–13

procedures 3–6
Quick Reference 3–5

hotkeys commands
access Help and Support 3–6
display brightness 3–8
initiate QuickLock 3–8
initiate Standby 3–8, 4–11
media commands 3–9
Open Internet Explorer 3–6
Quick Reference 3–5
switch image 3–7

hub, USB 8–3
humidity specifications A–2

I
IDE (Integrated Drive Electronics) 

light 5–4
identifying components

additional 2–17
display 2–2

infrared port 2–13, 7–8
InterVideo WinDVD

creating DVDs 6–19, 6–20
error message 6–11
managing region settings 6–12

J
jack

audio-out 2–11, 6–6
microphone 2–11, 6–6
RJ-11 2–9
RJ-45 2–9
S-Video 2–9, 2–11, 6–8

Japan-specific modem adapter 
2–18
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K
key

applications 2–4
fn 2–4
function (F1, F2, etc.) 2–4
hotkeys 3–4
keypad 2–4, 3–10
Microsoft logo 2–4
See also button; latch; switch, 

display
keyboard language 1–10

L
label

Microsoft Certificate of 
Authenticity 2–16, 9–9

modem approvals 2–16
product identification 2–16
system 2–16
wireless certification 2–16

language
choosing during setup 1–8
selecting keyboard 1–10

latch
battery pack locking 4–27
battery pack release 2–14
display release 2–2
See also button; switch, display

light
battery 2–8
caps lock 2–6
hard drive 2–8

IDE drive 5–4
power/standby 2–8

line-out jack 2–11, 6–6
lock, security cable 8–18
locked system 1–10, 2–5, 4–10
locking latches, battery pack 4–27

M
Maintenance, Shipping and Travel 

guide 2–19
media hotkeys 3–9
Media Player, Windows 6–10
media, drive

affected by airport security 5–3
canceling AutoPlay on 5–12
caring for 5–3
displaying contents of 5–12
inserting, removing CD or 

DVD 5–9
types and terms 5–2
See also drives

memory
compartment 2–14
displaying amount of 8–12
increasing RAM 8–12
module, removing or inserting 

8–13
modules supported 8–12

microphone jack 2–11
microphone, connecting 6–6
Microsoft Certificate of 

Authenticity label 2–16
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Microsoft logo key 2–4
model, identifying notebook 9–2
modem

approvals label 2–16
cable 2–17
connecting 7–3
country-specific adapter 2–18
specifications 7–2
virus protection 1–11

Modem and Networking guide 
2–19

monitor, external
external monitor connector 2–9
switching display 3–7

mouse, external
USB connectors 2–9, 2–11

multimedia card 8–8

N
network

cable 2–17
RJ-45 jack 2–9
specifications 7–3
speed 7–3

Norton AntiVirus 2003 1–11
notebook model, family, type, and 

serial number 9–2
NTSC television format 6–9
num lock light 2–6
number

Product Key 2–16
serial 2–16

numeric keypad 3–10

O
opening the notebook 1–4, 2–2
operating environment 

specifications A–2
operating system

installing retail version of 9–11
loading 4–9
Microsoft Certificate of 

Authenticity label 2–16
Product Key number 2–16
reinstalling 9–8
repairing 9–8
shutting down 4–9, 4–10

Operating System CD 9–8, 9–9
optical disc. See CD(s); DVD(s)
optical drive

avoiding Standby and 
Hibernation while using 5–13

boot order 5–14
identifying 2–13
See also drives

P
PAL, PAL-M television formats 

6–9
parallel connector 2–9
passwords 9–11
PC Card

configuring 8–5
functions 8–4
inserting, removing 8–5
stopping 8–6
types available 8–5

PC Card eject button 2–13
pointing device 3–3
port, infrared 2–13, 7–8
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power
button 2–5
connecting the notebook to 

external 1–5
conservation 4–4, 4–25
controls 4–8
cord 2–17
emergency shutdown 

procedures 4–10
Hibernation procedures 4–10
power connector 2–11
power/standby light 2–8
rated input A–2
setting preferences 4–13
shutting down the notebook 

1–10
Standby procedures 4–11
turning on the notebook 1–7
See also battery pack

power button
function, changing 4–13
identifying 4–8
resetting with 4–10

power connector
connecting 1–5
identifying 2–11

power cord
connecting 1–5
identifying 2–17
See also cable

Power Meter 4–18
power, AC 1–12

power/standby light 4–8
Preboot eXecution Environment 

(PXE) 7–4
preloaded utilities 1–9
Product Key number 2–16
projector

connecting 2–9
switching display 3–7

PXE (Preboot eXecution 
Environment) 7–4

R
RAM (Random Access Memory) 

8–12
region settings

currency, date, language, time 
1–10

DVD 6–12
Regulatory and Safety Notices 

guide 2–19
regulatory information

modem approvals label 2–16
notices 1–12
Regulatory and Safety Notices 

guide 2–19
system label 2–16
wireless certification label 

2–16
release latch

battery pack 2–14
display 2–2

repairing the operating system 9–8
reset (emergency shutdown 
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resolution, screen 1–10
restoring software 2–19
RJ-11 telephone jack

identifying 2–9
modem cable 2–17

RJ-45 network jack
identifying 2–9
network cable 2–17

ROM
defined 9–2
determining current version of 

9–3
downloading and installing 9–4
obtaining updates 9–4

RomPaq, downloading 9–4

S
Safety & Comfort Guide 2–19
safety considerations 1–12
security cable

lock, connecting 8–18
slot 2–9

serial number, notebook 2–16, 9–2
series, notebook 9–2
Setup utility 9–11
shutdown procedures 1–10, 4–9
sleep button 3–8, 4–13
Sleep. See Standby
slot

memory 8–12
PC Card 2–13

SD Card 8–8
security cable 2–9

socket services, PC Card 8–5
SoftPaq

described 9–4
downloading and installing 9–6

software
antivirus protection 1–11
AutoPlay 5–12
infrared 7–8
installing optional 1–9
network 7–4
Norton AntiVirus 2003 1–11
Power Meter 4–18
regional settings 1–10
reinstalling 9–8, 9–10
repairing 9–8
restoring 2–19
RomPaq 9–4
Setup utility 9–11
SoftPaq 9–4
updating preloaded software 

9–2
Windows Media Player 6–10
WinDVD 6–11

software updates
downloading and installing 

9–4, 9–6
obtaining 9–4
preparing for 9–2

speakers, external 6–6
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specifications
dimensions A–1
modem 7–2
network 7–3
operating environment A–2
rated input power A–2

Standby
avoiding when playing media 

5–13
avoiding when using infrared 

7–9
controls and indicators 4–8
initiating 3–8, 4–11
power/standby light 2–8
resuming from 4–11
setting preferences 4–13

S-Video
connections 6–8
jack 2–9

system label 2–16
system lockup 1–10, 2–5, 4–10
System Restore utility 9–7

T
technical support

getting help 1–13
notebook documentation 2–19

telephone (RJ-11) jack
identifying 2–9
modem cable 2–17

telephone numbers, service and 
support 1–13

television
changing color format 6–9
connecting audio 6–6
connecting video 6–8

temperature
specifications A–2
storage, battery pack 4–24

1394 connector 2–11
time, settting the 1–10
TouchPad

components 3–3
setting preferences 3–3

traveling with notebook
battery pack temperature 

considerations 4–24
environmental specifications 

A–2
modem approvals label 2–16
regional settings 1–10
serial number 2–16
wireless certification label 

2–16
troubleshooting

Troubleshooting guide 2–19
turning off notebook 1–10, 4–9, 

4–10
turning on notebook 1–7, 4–9

U
unresponsive system, emergency 

shutdown procedures 1–10, 4–10
USB

connectors, identifying 2–9, 
2–11

devices, connecting 8–3
utilities, preloaded

displaying descriptions 1–9
installing 1–9
See also software
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V
VCR

audio-out jack
function 6–6

connecting 6–8
vents, fan 2–10, 2–12, 2–15
video CDs, DVDs. See CD(s); 

DVD(s)
video device

connecting audio 6–8
S-Video jack 6–8
turning on and off 6–9

viruses, computer 1–11
volume, adjusting 6–3

W
Windows applications key 2–4
Windows Media Player

accessing with Digital Audio 
button 6–10

using with audio CDs
WinDVD

error message 6–11
managing region settings 6–12

wireless device
certification label 2–16
turning on and off 7–6

wireless network 7–5
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